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GENERAL INFORMATION
SECTION 1   GENERAL INFORMATION
1.1 SCOPE OF MANUAL

This addendum updates the following LTR® 
9800-series service manual with the additional infor-
mation needed to service 9800-series SMARTNET™/
SmartZone® transceivers. 

98xx Series UHF/800/900 MHz Service Manual,
Part No. 001-9800-001

1.2 DIFFERENCES BETWEEN LTR AND 
SMARTNET/SMARTZONE VERSIONS

1.2.1 HARDWARE DIFFERENCES

The 98xx SMARTNET/SmartZone transceivers 
use the same basic PC boards and mechanical package 
used for high tier LTR models. The only change is the 
addition of a DSP board that mounts on top of the 
current audio/logic board. This DSP board provides 
the SMARTNET/SmartZone control and signal 
processing functions.

Therefore, use the service manual listed above to 
service all boards except the DSP board. Service and 
interfacing information for that board is located in 
Section 5 of this addendum.

1.2.2 SOFTWARE DIFFERENCES

The audio/logic and DSP board operating soft-
ware (firmware) is unique to this transceiver. In addi-
tion, the programming and tuning software is also 
different. Therefore, new Operation, Programming, 
and Alignment sections are included in this manual.

The programming and tuning programs are now 
Windows® based. Therefore, Windows 95, 98, or NT 
4 or later is required to run these programs. The 
programming software is called PCTrunk™, and the 
alignment software is called PCTune™. Refer to 
Sections 1.5.5 and 1.5.6 for more information on 
programming and alignment. 

1.3 TRANSCEIVER IDENTIFICATION

The transceiver identification (serial) number is 
printed on a label that is attached to the chassis. The 
information contained in this number is as follows.

1.4 PART NUMBER BREAKDOWN

The following is a breakdown of the part number 
used to identify this transceiver. 

98xx        A A              02 0          A       12345

Model Revision
Letter

Manufacture
Date

Warranty
Number

Week No. of Year

Last Digit of Year

A = Waseca
Type

 

PlantFrom P.N.

A = SMARTNET/
SmartZone

2 = LTR
3 = SMARTNET
4 = Multi-Net
5 = SmartZone
6 = LTR-Net
8 = Data LTR
9 = Data Multi-Net
0 = Conv only*

242 - 9 8 x  x -x x x x
Band

Config.

Freq Range

Signaling

Type
1 = Low tier, dual BW
2 = Mid tier, dual BW*
3 = High tier, dual BW
4 = Low tier, 12.5 kHz
5 = Mid tier, 12.5 kHz*
6 = High tier, 12.5 kHz
8 = High tier rem, dual BW
0 = High tier rem, 12.5 kHz

1 = VHF*
4 = UHF
8 = 800 MHz
9 = 900 MHz

0 = Full band (800/
900 MHz)

3 = 430-470 MHz
5 = 470-512 MHz

B/N = Comp/Data
C/O = Compander
D/P = Data Cable
E/Q = Enc/Comp
F/T = Enc/Comp/Dat
G/U = Comp/Acsry
H/V = Horn/Acsry
I/W = Enc/Comp/

Acsry Cable

[1] N-W models are 
LTR-Net upgradable

Options [1]

1 = Low Pwr std*
2 = Mid Pwr std
3 = High Pwr std
6 = Low Pwr std*
7 = M.P. no acc
8 = H.P. no acc

NOTES:
1. * These configurations are currently not available.
2. Mid power = 25W UHF, 15W 800/900 MHz;

High power = 40W UHF, 30W 800/900 MHz
1-1
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GENERAL INFORMATION
1.5 MISCELLANEOUS

1.5.1 ACCESSORIES 

Table 1-1 is a partial listing of accessories that are 
available for 9800-series transceivers. Refer to this 
table in the service manual for other accessories that 
are available.

1.5.2 KEY CAP KITS

Key Cap Kit, Part No. 587-9840-003, is included 
with each transceiver. This kit includes the five key 
caps listed below. 

EMER F1 F2 F3 SCAN

Optional Key Cap Kit, Part No. 587-9840-105, is 
also available. This kit includes the key caps shown 
below.

F1 F2 F3 F4 SCAN
BKLHT MSG HORN C/S DISP
PRIED SELSQ MON TGSEL PHONE
RESP NUIS STATUS TXPWR (Blank)
ALERT EMER RWS TONES (Blank)

To remove a key cap, insert a tool with a sharp tip 
in the slot on the bottom of the cap and carefully pry 
against the front panel to release the cap. 

1.5.3 SYSTEMS, CHANNELS, AND ZONES

A zone and channel are selected to place and 
receive calls. The following describes the relationship 
between systems, channels, and zones.

Systems

A system as used with this transceiver is a collec-
tion of channels (talk groups) belonging to the same 
repeater site. A system defines all the parameters and 
protocol definitions required to access a site. Up to 
1 conventional system and 15 SmartNet/SmartZone 
systems can be programmed (16 total). Systems are 
used for programming purposes only and are not 
selectable by the user.

Channels

A channel selects a radio channel or talk group in 
a system as follows:

Conventional Mode - A channel selects a specific 
radio channel, Call Guard (CTCSS/DCS) squelch 
coding, and other parameters unique to that channel.

SmartNet/SmartZone Mode - A channel selects a 
specific talk group, announcement group, emergency 
group, and other parameters unique to that channel.

As previously described, a maximum of up to 256 
channels can be programmed with the preceding 
modes. The conventional system can be programmed 
with up to 256 channels, and each SmartNet/Smart-
Zone system can be programmed with up to 256 talk 
groups (channels). 

Therefore it is theoretically possible to program 
any combination of these systems that produces up to 
256 total channels. However, the maximum number 
may be limited by the available memory. For example, 
since more memory is required to program a SmartNet 
system than a conventional system, the total number of 
channels decreases as the number of SmartNet systems 
increases. The programming software displays a bar 
graph which shows the amount of available memory 
space that is used by the current data. Refer to Section 
3.1.10 for more information. 

Table 1-1   98xx Accessories

Accessory Part No.

Optional SMARTNET/SmartZone key cap 
kit (see Section 1.5.2)

587-9840-105

Programming Accessories
Remote Programming Interface (RPI) 023-9800-000
Cable, RPI to transceiver 597-2002-200
Cable, RPI to computer, 6 ft.
(DB9F to DB9M)

597-5900-002

PCTrunk personality programming
software, Win 95/NT, CD-ROM 

023-9998-453

PCTune alignment software (see Section 
1.5.6)

Contact Cust. 
Service
1-2
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GENERAL INFORMATION
Zones

A zone is a collection of up to 16 channels of any 
type (conventional or SmartNet/SmartZone). For 
example, a zone could include 12 conventional chan-
nels and 4 SmartNet channels. Zones are similar to 
banks used in other EFJohnson transceivers. One use 
of zones may be to program the channels used for 
operation in a specific geographical area. Up to 16 
zones can be programmed.

1.5.4 NPSPAC MODELS

All 800 MHz models meet the stricter specifica-
tions established by NPSPAC (National Public Safety 
Panel Advisory Committee) for public safety frequen-
cies from 821-824 and 866-869 MHz. Maximum devi-
ation on NPSPAC channels is 4 kHz, and it is automat-
ically changed to the level set for NPSPAC channels 
when one of these channels is selected.

1.5.5 PROGRAMMING

The transceiver is programmed using a PC-
compatible computer, the EFJohnson Remote 
Programming Interface (RPI), and the PCTrunk™ 
programming software (see Table 1-1). Programming 
is described in Section 3. The operating software 
(firmware) is Flash upgradable if required. Keypad 
programming is not available with this transceiver.

1.5.6 TRANSCEIVER ALIGNMENT

Transceiver alignment is performed using the 
same computer and RPI used to perform program-
ming (see preceding section) and special PCTune™ 
software. Only three adjustments are made manually 
and the rest are made electronically using the PCTune 
software. Therefore, if the manual adjustments do not 
require readjustment, the transceiver can be tuned 
without removing the top cover to access internal 
adjustments. Refer to Section 4 for more information.
1-3
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OPERATION
SECTION 2   OPERATION
Figure 2-1   Front Panel Controls And Indicators

EMER

F3

F2

F1

SCAN

C PS

Option Switches

Microphone
Jack

On-Off/Volume
(Press/Rotate)

Select Switch
(Press/Rotate)

Speaker
2.1 FEATURES

2.1.1 GENERAL FEATURES

• Up to 16 zones with home zone select
• Up to 16 channels per zone (256 channels total)
• Standard and radio-wide scan
• Five programmable option switches
• Time-out timer
• 16-character LCD alphanumeric display with

8 status annunciators

2.1.2 CONVENTIONAL FEATURES

• Up to 256 channels programmable
• Scanning with three user programmable scan lists
• Priority channel sampling when scanning
• Busy channel lockout (transmit disable on busy)
• Monitor mode
• Call Guard® (CTCSS/DCS) or carrier squelch 

control
• Penalty and conversation timers
• Repeater talk-around
• DTMF/ANI signaling
• User selectable high and low power output

2.1.3 SMARTNET™ II FEATURES

• Up to 256 talk groups programmable
• Group, Enhanced Private Conversation™, Private 

Conversation II™, and telephone Calls
• Call Alert™ (paging)
• Emergency alarms and calls
• Messaging
• Priority monitor scanning with user programmable 

scan lists
• Failsoft operation
• Dynamic regrouping

2.1.4 SMARTZONE® FEATURES

• Site trunking
• Site search
• Site lock/unlock

2.2 CONTROLS AND DISPLAY

On-Off Volume - Pressing this knob turns power on 
and off, and rotating it sets the speaker volume (see 
Section 2.3.2).
2-1
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OPERATION
Select Switch - Rotating this switch increases or 
decreases the selected channel. It is also used for other 
functions such as selecting the zone and scrolling 
through lists. See Section 2.3.5 for more information. 

Option Switches - The five front panel option switches 
can be programmed for various functions. Refer to 
Section 2.3.4 for more information. 

Transmit/Busy Indicator - Indicates the following 
conditions:

Red - Transmitter is keyed
Green - The currently selected receive channel may 

be busy because a carrier (signal) is being 
detected (see Section 2.4.3).

Microphone Jack - Connection point for the 
microphone.

Microphone Push-To-Talk (PTT) Switch - Push-
button on the microphone which is pressed to key the 
transmitter. 

Speaker - The internal speaker is located behind the 
grille. An optional speaker can be connected to the 
external speaker jack located on the back. See “Speaker 
Jack” description in next section for more information.

2.2.1 REAR PANEL JACKS AND CONNECTORS

Antenna Jack - Miniature UHF jack for connecting the 
50-ohm antenna.

Power Jack - Connection point for the power cable 
which attaches to the vehicle battery. A nominal 12-volt 
DC, negative ground power source is required.

Speaker Jack - Connection point for an optional 
external 4.7-ohm, 5-watt speaker. The internal speaker 

is automatically disabled when a speaker is plugged 
into this jack.

Accessory Cable (Not Shown) - This optional pigtail 
cable installs in the speaker jack opening and is used 
to connect the ignition sense input and other outputs. 

2.2.2 DISPLAY DESCRIPTION

Upper 8-Character Display - This alphanumeric 
display indicates the channel alias or information 
about the selected mode. With conventional operation, 
it may also indicate the channel number or frequency 
(see Section 2.4.2). 

Lower 8-Character Display - This alphanumeric 
display indicates additional information pertaining to 
the current mode when necessary. 

 - Indicates that standard scanning is enabled (see 
Section 2.3.11). Standard and radio wide scanning 
cannot be enabled at the same time. 

 - The box around the “S” indicates that the current 
conventional or SMARTNET/SmartZone channel is in 
the standard scan list (Section 2.3.11).

 - With SMARTNET/SmartZone channels only, 
indicates that the telephone (interconnect) mode is 
selected (Section 2.5.6). 

Antenna
Jack

Ext. Speaker
Jack

Power
Jack

C PS G

In Scan
List

Priority
Channel

Radio-

Upper and Lower Monitor

Wide Scan
Std Scan

Talk-Around Private
Call

Telephone Call

Keypad
Prg Mode

8-Character Displays Mode Mode

Enabled
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 - Indicates that radio-wide scan is enabled (see 
Section 2.3.11).

 - Indicates that repeater talk-around is enabled on 
the selected conventional channel (see Section 2.4.9).

 - Indicates that a SMARTNET/SmartZone private 
call is occurring (Sections 2.5.4 and 2.5.5).

 - Indicates that the conventional monitor mode is 
enabled (Section 2.4.4).

 - Indicates that the selected conventional channel is 
a priority channel (Section 2.4.12).

2.3 GENERAL OPERATION

2.3.1 INTRODUCTION

This section (2.3) describes features available 
with both conventional and SMARTNET/SmartZone 
(trunked) operation. For information on features 
unique to conventional channels, refer to Section 2.4, 
and for information on features unique to 
SMARTNET/SmartZone channels, refer to
Section 2.5. 

2.3.2 TURNING POWER ON AND SETTING 
VOLUME

Power is turned on and off by pressing the On-
Off/Volume switch on the front panel. When power is 
initially turned on, an alert tone sounds and the radio 
software version is momentarily displayed. The zone 
alias is then displayed followed by the unit ID if a 
SMARTNET/SmartZone channel is selected (see 
Section 2.5.2). The selected channel is then indicated. 
When power is turned off, the display may remain on 
for a few seconds. It is recommended that power not 
be turned back on again until the display is blank.

The volume level is adjusted by rotating the On-
Off/Volume switch. The relative volume level can be 
determined by noting the position of the index on the 
knob. You may also be able to enable a reference tone 
for setting the volume as follows:

• If key press tones are enabled (see Section 2.3.8), a 
short tone sounds when front panel option keys are 
pressed.

• If a conventional channel is selected and the 
Monitor option switch is programmed (see Section 
2.4.4), pressing that switch unsquelches/squelches 
the receiver and either voice or background noise is 
heard. If a SMARTNET/SmartZone channel is 
selected, the receiver cannot be manually 
unsquelched.

2.3.3 BACKLIGHT

The backlight for the display and keypad can be 
manually turned on and off if the Backlight option 
switch is programmed. Pressing this switch cycles 
between the Bright, Dim, and Off modes. If this switch 
is not programmed, the backlight is fixed in one of 
these modes.

2.3.4 OPTION SWITCHES

All five push-button switches on the front panel 
are programmable for the functions indicated in Table 
2-1. If your radio is programmed with both conven-
tional and SMARTNET/SmartZone channels (see 
Section 2.3.12), these option switches can be 
programmed to control a different set of functions for 
each channel type. For example, a switch could select 
the Monitor Mode when a conventional channel is 
selected and Private Calls when a SMARTNET/Smart-
Zone channel is selected. If no option switch has been 
programmed to control a particular function, that func-
tion may not be available or in a fixed mode.

2.3.5 CHANNEL AND ZONE SELECTION

Channel Select

To change the selected channel, rotate the Select 
switch. The selected channel alias (name) is indicated 
on the top line of the display. With conventional chan-
nels, the channel number or frequency may also be 
displayed as described in Section 2.4.2.

Zone Select

A zone is a group of up to any 16 conventional 
and SMARTNET/SmartZone channels defined by 
programming (see Section 1.5.3). Up to 16 zones can 
be programmed for a total of 16 x 16 or 256 channels. 
One use of zones may be to select groups of channels 
programmed for operation in different geographical 
areas or radio systems. Zones are selected as follows:
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1. Press the Zone option switch and the alias (name) of 
the current zone is indicated on the upper line of the 
display. 

2. Rotate the Select switch to display the desired zone. 
Then to select that zone and exit this mode, press the 
Select switch or wait 4 seconds.

2.3.6 HOME ZONE

The radio can be programmed with a home zone. 
Then when power is turned on, the radio can be 
programmed so that either the home zone or last 
selected zone is automatically selected.

If the Home Zone option switch is programmed, 
it can be used to quickly select or change the home 

zone. To select the home zone, simply press this 
switch. Then to change the home zone to the currently 
selected zone, press and hold this switch until a tone 
sounds (approximately 1 second). 

2.3.7 TIME-OUT TIMER

The time-out timer disables the transmitter if it is 
keyed for longer than the programmed time. It can be 
programmed on each channel for times from 15 
seconds up to 3 minutes, 45 seconds or disabled (not 
used). If the transmitter is keyed continuously for 
longer than the programmed time, the transmitter is 
disabled and an invalid condition tone sounds. Five 
seconds before time-out occurs, an alert tone sounds to 
indicate that time-out is approaching. The timer and 
tone are reset by releasing the PTT switch. 

One use of this feature is to prevent a channel 
from being kept busy for an extended period by an 
accidentally keyed transmitter. It can also prevent 
possible transmitter damage caused by transmitting for 
an excessively long period. Conventional channels can 
also be programmed with the Penalty and Conversa-
tion timers that are described in Sections 2.4.7 and 
2.4.8.

2.3.8 TONE ENABLE/DISABLE

The supervisory tones (see Section 2.6) can be 
enabled and disabled by the Tones On-Off option 
switch if it is programmed. When tones are enabled by 
this switch, “TONE ON” is momentarily displayed on 
the lower line and a tone sounds. Conversely, when 
tones are disabled, “TONE OFF” is displayed and no 
tone sounds. If the Tones On-Off option switch is not 
programmed, tones are fixed in the on or off mode by 
programming.

2.3.9 POWER TURN-OFF DELAY

The transceiver can be installed so that the 
vehicle ignition switch as well as the front-panel 
power switch controls transceiver power. This is done 
by connecting the accessory ignition switch wire to a 
power source switched by the ignition switch. Power 
off delays of 0-254 minutes or Forever can then be 
programmed. This delay can be overridden at any time 
by turning power off using the front-panel power 
switch or turning the ignition switch back on.

Table 2-1   Option Switch Functions

Function
[Sugg. Sw. Label]

Conv.
Mode

Smart
Net 

Mode

Smart-
Zone
Mode

See
Section

Backlight [BKLHT] X X X 2.3.3
Call Alert [ALERT] X X 2.5.7
Call Response [RESP] X X 2.5.4, 2.5.5
Displayed Information
[DISP]

X 2.4.2

Emergency [EMER] X X 2.5.10
High/Low Power 
[TxPWR]

X 2.4.10

Home Zone X X X 2.3.6
Message [MSG] X X 2.5.8
Monitor [MON] X 2.4.4
Normal/Selective 
[SELSQ]

X 2.4.6

Phone [PHONE] X X 2.5.6
Priority Edit [PRIED] X 2.4.12
Private Call X X 2.5.4, 2.5.5
Radio Wide Scan 
[RWS]

X X X 2.3.11

Repeater Talk-Around X 2.4.9
Scan [SCAN] X X X 2.3.11
Scan Edit X X X 2.4.11
Site Lock X 2.5.14
Site Search X 2.5.14
Status [STATUS] X X 2.5.9
Tones On-Off [TONES] X X X 2.3.8
Zone X X X 2.3.5
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A turn-off delay allows the radio to remain active 
for the programmed delay time after the ignition switch 
is turned off. At the same time, advantages of ignition 
switch control can be utilized such as preventing 
battery discharge that may occur if the transceiver is 
accidentally left on for an extended period.

2.3.10 TEMPERATURE AND VOLTAGE 
MONITORING

Excessive Transceiver Temperature

If the internal transceiver temperature becomes 
excessive, a tone sounds and “HOT” is displayed on 
the bottom line. Transmit power is then automatically 
cut back to approximately 1/3 of normal to limit heat 
generation. When the temperature is not longer exces-
sive, power output automatically returns to normal. 
This condition may be caused by transmitting for 
extended periods or operating in a very warm 
environment. 

If the temperature continues rising to the point 
where serious transceiver damage could result, “TOO 
HOT” is displayed, a tone sounds, and the transmitter 
is disabled. The PTT switch must then be released and 
the temperature drop to the excessive range or lower to 
transmit again. 

Low Voltage Conditions

If the voltage applied to the transceiver decreases 
to the point where improper operation could result, 
“LO VOLT” is displayed on the bottom line, a tone 
sounds, and the transmitter is disabled. This condition 
is usually caused by a discharged vehicle battery. To 
clear this condition, operate the vehicle to charge the 
battery or transmit with the vehicle running.

2.3.11 SCANNING

Introduction

Scanning cycles through a list of channels, called 
a “scan list”, checking each for messages. When a 
message is detected that your transceiver is 
programmed to receive, scanning stops and the 
message is received. Shortly after the message is 
complete, scanning resumes (unless it has been 
disabled). If the microphone off-hook condition is 

detected, the microphone must also be on-hook for 
scanning to occur. An off-hook condition also disables 
coded squelch as described in Section 2.4.3

There are two basic scan modes: Standard and 
Radio Wide. The Standard mode is unique to the type 
of channel selected (conventional or SMARTNET/
SmartZone), and the Radio Wide mode is the same 
regardless of the channel type selected. Only one of 
these scan modes can be enabled at a time. Therefore, 
if standard scanning is enabled while radio wide scan-
ning is occurring, radio wide scanning is automatically 
disabled and vice versa. More information on these 
modes follows.

Standard Scanning

Standard scanning monitors only channels that 
are the same type as that currently selected. There-
fore, if a conventional channel is selected, only 
conventional channels are scanned, and if a 
SMARTNET channel is selected, only SMARTNET 
channels are scanned. Standard scanning is turned on 
and off by the Scan option switch as follows. If this 
switch is not programmed, standard scanning is not 
available.

• To turn standard scanning on, press the Scan option 
switch. Scanning is enabled when the “S” icon is 
indicated in the upper left corner of the display and 
SCAN x (conventional) or SCAN ON 
(SMARTNET/SmartZone) is briefly displayed on 
the lower line of the display. The “x” is the number 
of the conventional scan list (1, 2, or 3) that is 
selected. Refer to Section 2.4.11 for more
information.

• To turn scanning off, press the Scan option switch 
again. The “S” icon is then no longer indicated and 
“SCAN OFF” is briefly displayed.

• If the zone or channel is changed while scanning is 
selected, scanning continues on the same or a 
different scan list (see scan list information which 
follows).

Radio Wide Scanning

Radio wide scanning monitors the channels in the 
preprogrammed radio wide scan list (see information 
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which follows). This list may contain up to 16 chan-
nels of any type (conventional or SMARTNET/Smart-
Zone) assigned to any zone. Radio wide scanning is 
turned on and off by the Radio Wide Scan option 
switch as follows. If this switch is not programmed, 
radio wide scanning is not available. 

• To turn radio wide scanning on, press the Radio 
Wide Scan option switch. The  icon is then 
displayed continuously and “RWS ON” is displayed 
briefly on the lower line of the display. 

• To turn radio wide scanning off, press the Radio 
Wide Scan option switch again. The  icon is then 
no longer indicated and “RWS OFF” is displayed 
briefly.

• If the zone or channel is changed while radio wide 
scanning, scanning continues normally.

Scan Resume Delay

When a message is received or transmitted while 
scanning, there is a programmable delay before scan-
ning resumes. The delay after receiving a call prevents 
another message from being received before you can 
make a response, and the delay after transmitting a call 
ensures that you hear a response to your call instead of 
another message occurring on some other channel.

Standard Mode Scan List

NOTE: The selected channel is always scanned.

With conventional operation, up to three scan lists 
can be programmed. The list that is scanned is selected 
by the Scan option switch as described on Section 
2.4.11. Selecting another conventional channel does 
not change the current scan list. The scan lists are user 
programmable if the Scan Edit option switch is 
programmed (see “Programming a Scan List” which 
follows).

With SMARTNET/SmartZone operation, each 
channel can be programmed so that one of up to three 
different scan lists is automatically selected or scan-
ning is disabled. The scan lists are user programmable 
if the Scan Edit option switch is programmed (see 
“Programming a Scan List” which follows).

Radio Wide Mode Scan List

With radio wide scanning, there is only one 
preprogrammed scan list available regardless of the 
type of channel selected, and it is not user 
programmable. 

Determining Which Channels are in Scan List

With standard conventional scanning, the selected 
channel is in the current scan list if the box  icon 
(around “S”) is indicated in the upper left corner of the 
display. Channels in SMARTNET/SmartZone stan-
dard scan lists are indicated only when editing a scan 
list. Channels in the radio wide scan list are not
indicated.

Nuisance Channel Delete

With standard scanning, both conventional and 
SMARTNET/SmartZone channels can be temporarily 
deleted from the scan list. This feature is not available 
with radio wide scanning. Proceed as follows:

NOTE: The selected channel and conventional priority 
channels cannot be deleted from the scan list.

1. While receiving a message on the channel to be 
deleted, press and hold the Scan option switch until 
the alert tone sounds (about 1 second). 

2. The channel is then deleted and scanning of the 
remaining channels in the scan list resumes.

3. Deleted channels are added back into the scan list if 
any of the following occur:

• Scanning is turned off and then on again using the 
Scan switch.

• The selected channel is changed.
• Transceiver power is turned off and then on again.

Programming a Scan List

If the Scan Edit option switch is programmed, 
conventional and SMARTNET/SmartZone standard 
scan lists can be user programmed as follows: 

1. Make sure that both standard and radio wide scan-
ning are off (neither the standard scan “S” icon or 
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radio-wide scan  icon is displayed). Then press 
the Scan Edit option switch to select the scan list 
edit mode. 

2. With conventional channels, if applicable, select the 
list to be edited (1-3) by rotating and then pressing 
the Select switch. The selected list is indicated as 
“SCAN x”, where “x” is the list number from 1-3. If 
user programming is disabled on a list, “NO LIST” 
is momentarily displayed and it cannot be edited.

With SMARTNET/SmartZone channels, the scan 
list for the selected channel is fixed and cannot be 
changed. Scanning may also be disabled on the 
channel in which case “NO LIST” is momentarily 
displayed and scan list editing is not available.

3. Select the channel you want to add or delete by 
rotating the Select switch. After the last conven-
tional channel in the current zone is displayed, the 
first valid channel in the next zone is displayed and 
vice versa. SMARTNET/SmartZone lists are 
limited to 16 channels. If an attempt is made to add 
more than 16, “LIST FULL” is displayed and a 
channel must be deleted before another can be 
added. 

4. If the selected channel is in the scan list (scanned), 
the box  icon (around “S”) is indicated in the 
upper left corner of the display. To change the status 
of the displayed channel, press the Select switch.

NOTE: The priority channel cannot be deleted (see 
“Priority Channel Sampling” description which 
follows).

5. To exit this mode and save the changes, press the 
Scan Edit option switch again.

2.3.12 CONVENTIONAL AND SMARTNET/
SMARTZONE OPERATION

Introduction

Each selectable channel is programmable for 
either conventional or SMARTNET™/SmartZone® 
(trunked) operation. For example, Zone 1/Channel 1 
could be a conventional channel, Zone 1/Channel 2 a 
SMARTNET/SmartZone channel, and so on. More 
information on these modes follows. 

Conventional Operation

This is a non-trunked operation mode which 
accesses independent radio channels (there is no auto-
matic access to several channels as with trunked oper-
ation). Monitoring before transmitting may not occur 
automatically in this mode, so you may have to manu-
ally monitor the channel before transmitting to make 
sure that it is not being used by anyone else (see 
Section 2.4.3). Selecting a conventional channel 
selects a transmit and receive frequency and other 
parameters such as Call Guard squelch coding. 

SMARTNET/SmartZone Operation

This is a trunked operating mode that uses ID 
codes to select which mobiles are being called and 
which calls are received. Monitoring is performed 
automatically and special messages and tones indicate 
busy and out-of-range conditions. Enhanced features 
include roaming (SmartZone only), telephone, private, 
and emergency calls, Call Alert, and messaging. Oper-
ating features unique to SMARTNET/SmartZone 
channels are described in Section 2.5.

This radio supports only the SMARTNET II 
trunking protocol. It does not support the 
SMARTNET I (also referred to as Type I) protocol. 
When a SMARTNET or SmartZone channel is 
selected or the radio is powered up on one of those 
channels, it searches for a control channel and 
attempts to register on the radio system. Once a 
control channel is found, the alias (name) of the 
selected channel is displayed. If a control channel 
could not be found (because of an out of range condi-
tion or the system ID is not correct, for example), “NO 
SYS” is displayed and the radio continues to search 
for a control channel.

The control channel transmits and receives 
system information to and from all radios registered on 
the system. Therefore, once a control channel is found, 
it is continuously monitored for incoming call infor-
mation and is used to make call requests. The radio 
automatically changes to a traffic channel to place and 
receive calls and then returns to the control channel 
when the call is complete.
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2.4 CONVENTIONAL FEATURES

2.4.1 INTRODUCTION

The following information describes features 
unique to the conventional operating mode (described 
briefly in Section 2.3.12). Refer to Section 2.3 for 
information on features common to all operating 
modes, and to Section 2.5 for information on features 
unique to the SMARTNET/SmartZone mode. 

2.4.2 DISPLAY MODE SELECTION

If the Displayed Information option switch is 
programmed, the display mode used to indicate 
conventional channels can be user selected. Pressing 
this switch cycles between the following modes. The 
selected mode does not change when power is turned 
off. If the Displayed Information option switch is not 
programmed, the Alias mode is always used. 

Alias - The preprogrammed alphanumeric tag for 
the channel is displayed. 

Number - The channel number from 1-16 is 
displayed. 

Frequency - The receive frequency of the selected 
channel is displayed in megahertz. 

2.4.3 MONITORING BEFORE TRANSMITTING

With conventional operation, channels are moni-
tored automatically or manually as follows:

Automatic Channel Monitoring

If the selected channel is programmed for the 
Busy Channel Lockout feature, monitoring is 
performed automatically. Refer to the description of 
this feature in Section 2.4.5 for more information.

Manual Channel Monitoring

The automatic monitoring just described may not 
be programmed or it may occasionally disable the 
transmitter even if the channel is not in use. In this 
case, the channel must be monitored manually as 
follows:

Busy Indicator - With scanning disabled, note if the 
Transmit/Busy indicator on the front panel is green. 
If it is not, the channel is not being used and the call 
can be transmitted. If it is on, a carrier is being 
detected, so the channel may be busy (see next
paragraph). 

Monitor Mode - There may be times when the busy 
indication is displayed even though no one is using 
the channel. Monitoring should then be performed 
by disabling Call Guard squelch by taking the 
microphone off-hook (if off-hook detection is 
enabled), pressing the Normal/Selective switch as 
described in on Section 2.4.6, or by selecting the 
monitor mode as described next.

2.4.4 MONITOR MODE

The monitor mode temporarily disables squelch 
control features (such as Call Guard® squelch) so that 
all messages are heard on the selected channel. It also 
overrides the Busy Channel Lockout feature (see next 
section) and temporarily disables scanning.

To monitor the selected channel, select the 
monitor mode by briefly pressing the MON option 
switch (if available). The  icon is displayed and the 
receiver unsquelches when the monitor mode is 
enabled. To disable the monitor mode and return to 
normal operation, press the MON switch a second 
time.

When scanning is enabled, pressing and holding 
the MON option switch until a tone sounds (approxi-
mately 1 second) monitors the scanned channel instead 
of the selected channel.

2.4.5 BUSY CHANNEL LOCKOUT

The Busy Channel Lockout feature (also called 
Transmit Disable On Busy) automatically disables the 
transmitter if the channel is busy when the PTT switch 
is pressed. When a busy condition is detected by this 
feature, the transmitter is disabled, “BUSY” is indi-
cated on the lower line of the display, and a tone 
similar to a standard telephone busy tone sounds until 
the PTT switch is released. This feature is 
programmed to operate in one of the following modes 
on each channel: 
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Off - The transmitter keys even if the channel is busy.
Noise - The transmitter is disabled if any signal is 

detected on the channel.
Tone - The transmitter is disabled if the detected 

squelch coding is not correct.

If busy override is permitted by programming, it 
is possible to transmit even when the transmitter is 
disabled by this feature. Simply release the PTT switch 
and then quickly press it again.

2.4.6 CALL GUARD SQUELCH

General

Call Guard® squelch (also called CTCSS/DCS 
signaling) may be programmed on conventional chan-
nels. This feature eliminates distracting messages 
intended for others using the channel by using a 
subaudible tone or digital code to control the squelch. 
This tone or code is unique to a user or talk group on 
that channel. It is transmitted by the mobile placing a 
call, and if Call Guard squelch is programmed in the 
mobile receiving the call, it must detect the correct 
tone or code to receive the call.

Call Guard Squelch Enable/Disable

To disable Call Guard (Selective) squelch so that 
all messages on the selected or scanned conventional 
channels are heard, take the microphone off-hook (if 
off-hook detection is enabled) or press the Normal/
Selective option switch if programmed. Then to re-
enable Call Guard squelch, place the microphone back 
on-hook or press the Normal/Selective switch again. 

When Call Guard squelch is disabled by the 
option switch, “SQ NORM” is flashed on the lower 
line of the display, and when it is enabled, “SQ SLCT” 
is flashed. The mode selected by this switch does not 
change when other channels are selected or power is 
cycled. Call Guard squelch can also be disabled by the 
monitor mode described in Section 2.4.4. 

2.4.7 PENALTY TIMER

A penalty timer may be programmed on conven-
tional channels to prevent transmissions for a time 
after the time-out timer described in Section 2.3.7 
disables the transmitter. The penalty timer starts when 

the PTT switch is released after the transmitter has 
been disabled. If the PTT switch is pressed during the 
penalty time, the time-out indication occurs again. A 
beep sounds when the penalty timer expires and the 
transmitter can then be keyed.

2.4.8 CONVERSATION TIMER

A conversation timer can be programmed on 
conventional channels to limit the total length of a 
conversation rather than just the length of each trans-
mission as with the time-out timer. This timer is reset 
when the time between transmissions exceeds the 
penalty time just described. A warning tone sounds 5 
seconds before the conversation timer expires. When it 
expires, the transmitter is disabled and a warning tone 
sounds. The transmitter remains disabled for the 
length of the penalty time, and a beep sounds when it 
can be keyed again.

2.4.9 REPEATER TALK-AROUND

Normally, all transmissions go through a repeater 
which usually increases range. However, if out of 
range of the repeater, you cannot talk to anyone else 
on that channel even though the mobile you are calling 
may be only a short distance away. To allow commu-
nication when this situation occurs, repeater talk-
around can be used to allow direct communication 
with a mobile without going through a repeater.

Repeater talk-around can be selected if the 
Repeater Talk-Around option switch is programmed. 
When talk-around is enabled by this switch, the  
icon is displayed and “RTA ON” is flashed on the 
lower line of the display. Then when it is disabled by 
pressing the switch again, that icon is no longer 
displayed and “RTA OFF” is flashed. Changing chan-
nels or turning power off does not change the selected 
talk-around mode.

2.4.10 POWER OUTPUT SELECT

If the High/Low Power option switch is 
programmed and power selection is permitted on the 
current channel by programming, either high or low 
transmitter power can be selected. Pressing this switch 
toggles the power setting. The new level is flashed on 
the lower line of the display when this switch is 
pressed as “HI POWER” or “LO POWER”. If power 
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selection is not permitted on the current channel, the 
fixed power level is flashed and no power change 
occurs. Turning power off or changing channels does 
not change the power setting selected for a channel.

2.4.11 CONVENTIONAL MODE SCANNING

General

The following information describes scanning 
features unique to conventional operation. Scan opera-
tion common to all modes is described in Section 
2.3.11, and scan operation unique to SMARTNET/
SmartZone operation is described in Section 2.5.12.

Selecting a Scan List

With conventional standard scanning, one of up 
to three scan lists can be selected. Scanning is turned 
on and off and the scan list selected by repeatedly 
pressing the Scan switch as follows: 

1. Press the Scan option switch once to enable scan-
ning and Scan List 1. The “S” icon is then indicated 
in the upper left corner of the display and “SCAN 1” 
is momentarily displayed on the bottom line. 

2. Press the Scan option switch again to select Scan 
List 2 (if available), and “SCAN 2” is momentarily 
displayed. Press it again to select Scan List 3 (if 
available).

3. Pressing the Scan option switch again disables scan-
ning (the “S” icon is no longer displayed). If the 
Scan option switch is pressed again, the cycle 
repeats.

Transmitting in Scan Mode

Each conventional scan list can be programmed 
for one of the following modes. These modes deter-
mine if priority sampling occurs and also the channel 
on which transmissions occur while scanning. Refer to 
the next section for more information.

No Priority - No priority channel sampling occurs 
when the list is selected. The radio transmits on the 
selected channel.

Priority/Tx Priority - Priority sampling occurs and 
the priority channel is the one programmed in the 

selected scan list. The radio transmits on the priority 
channel.

Priority/Tx Selected - Priority sampling occurs and 
the priority channel is the one programmed in the 
selected scan list. The radio transmits on the selected 
channel.

Priority on Selected - The priority channel is always 
the selected channel. The radio transmits on the 
selected channel. 

Talkback - No priority sampling occurs. The radio 
transmits on the channel of a call while scanning is 
halted. Then once scanning resumes, it transmits on 
the selected channel.

2.4.12 PRIORITY CHANNEL SAMPLING

General

The priority channel sampling feature ensures 
that when standard scanning, messages on the priority 
channel are not missed while listening to a message on 
some other channel. The transceiver can be 
programmed so that the priority channel is a fixed 
channel associated with the current scan list, the 
currently selected channel, or not used. When the 
selected channel is a priority channel, “P” is indicated 
in the upper right part of the display.

Priority channel sampling occurs only with Stan-
dard conventional scanning. It does not occur with 
Radio Wide scanning, when listening to any type of 
SMARTNET/SmartZone call, or when transmitting. A 
series of “ticks” may be heard when the priority 
channel is sampled while listening to a message on 
some other channel.

The priority sampling times are programmed by 
the following parameters:

Lookback Time A - This time determines how often 
the priority channel is checked for activity. Times of 
0.25-4.00 seconds in 0.25-second steps can be 
programmed.

Lookback Time B - This time determines how often 
the priority channel is checked once an incorrect Call 
Guard (CTCSS/DCS) code is detected. Since it takes 
much longer to detect an incorrect Call Guard signal 
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than a carrier, this time should be relatively long to 
prevent the interruptions from making a message diffi-
cult to understand. Times of 0.5-8.0 seconds can be 
programmed in 0.5-second steps.

Changing The Priority Channel

If a specific priority channel is associated with 
the current scan list, it can be changed if the Priority 
option switch is programmed. Proceed as follows:

1. Make sure all scanning is off (neither the standard 
scan “S” icon or radio-wide scan  icon is 
displayed).

2. Select the channel that you want to be the priority 
channel using the Select switch in the normal 
manner. If the channel is in a different zone, also 
select the appropriate zone.

3. Press the Priority option switch and the “P” icon is 
displayed to indicate that the selected channel is 
now the priority channel.

2.4.13 STANDARD CONVENTIONAL CALLS

Standard conventional calls are calls to or from 
other mobile units on the selected channel. The proper 
coded Call Guard signaling (see Section 2.4.6) may 
need to be transmitted for them to receive your call 
and also for you to receive their calls. Proceed as 
follows to place and receive these calls:

Placing a Standard Conventional Call

1. Turn power on and set the volume as described in 
Section 2.3.2. Select the channel programmed for 
the mobile you want to call (see Section 2.3.5).

2. Monitor the channel automatically or manually as 
described in Section 2.4.3.

3. Press the PTT switch and the call proceeds as 
follows:

• If the Busy Channel Lockout feature is 
programmed on the channel, the transmitter is 
automatically disabled if the channel is busy (see 
description in Section 2.4.5). 

• Otherwise, busy and out-of-range conditions are 
not indicated and speaking can begin after moni-
toring the channel. 

4. Press (and hold) the PTT switch to talk and release 
it to listen.

Receiving a Standard Conventional Call

1. Select or scan the channel programmed for the call 
you want to receive (refer to Sections 2.3.11 and 
2.4.11 for more scanning information).

2. When the call is received, press the PTT switch to 
talk and release it to listen. If scanning, you may 
have to respond before scanning resumes to ensure 
that the response occurs on the channel of the call. 

2.4.14 DTMF/ANI SIGNALING

DTMF (Dual Tone Multi-Frequency) tones can 
be generated manually or automatically for ANI 
(Automatic Number Identification) and other 
purposes. The following options may be enabled by 
programming for each conventional channel:

DTMF Keypad - Pressing 0-9, *, or # on the keypad 
of an optional DTMF microphone transmits the corre-
sponding tone (the PTT switch must also be pressed if 
the transmitter does not automatically turn on when a 
key is pressed). 

Pre-Tx ANI - A preprogrammed ANI sequence is 
automatically sent when you press the PTT switch.

Post-TX ANI - A preprogrammed ANI sequence is 
automatically sent each time you release the PTT 
switch. 

Disabled - ANI signaling is disabled.

2.5 SMARTNET/SMARTZONE FEATURES

2.5.1 INTRODUCTION

The following information describes the features 
unique to the SMARTNET/SmartZone operating 
mode described briefly in Section 2.3.12. Features 
common to all operating modes are described in 
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Section 2.3, and features unique to the conventional 
mode are described in Section 2.4.

2.5.2 VIEWING UNIT ID

Each radio in a SMARTNET system is identified 
with a system ID and Unit ID. To display the Unit ID, 
make sure that a SMARTNET/SmartZone channel is 
selected and then turn power off and then on again. 
The software version number, current zone, and six-
digit Unit ID are then displayed in sequence. The Unit 
ID is displayed as IDxxxxxx.

2.5.3 STANDARD GROUP CALLS

Standard calls are between you and another 
mobile, group of mobiles, or a control station (a radio 
at a fixed location). Most calls you make will probably 
be this type.

Placing a Standard Group Call

1. Turn power on and set the volume as described in 
Section 2.3.2. Select the channel programmed for 
the talk group you want to call (see Section 2.3.5). 
A regular or announcement talk group can be 
selected.

2. Press the PTT switch and when the alert tone 
sounds, begin talking. Other indications that may 
occur are as follows:

• If the busy tone sounds and “BUSY” is displayed, 
the system is busy. Release the PTT switch and 
wait for the call back tone to sound. Then press the 
PTT switch within 3 seconds and begin talking.

• If a continuous tone sounds while pressing the 
PTT switch, an out-of-range condition may exist. 
Drive closer or away from shielding objects and 
try again. 

• If your unit ID is invalid, the call is being made to 
an invalid group ID, or group calls are not allowed, 
“INVALID ID” is displayed and an alert tone 
sounds.

Receiving a Standard Call

When a SMARTNET/SmartZone group call is 
received, the transceiver can be programmed to 

display either the talk group of the incoming call or the 
ID of the radio making the incoming call. If the ID is 
in the Trunking Call List, the alias of that mobile is 
displayed instead of the ID. If neither of these features 
are programmed, the alias of the selected talk group 
continues to be displayed when a call is received. 

2.5.4 ENHANCED PRIVATE CONVERSATION 
CALLS

General

Private calls allow you to place a call to a specific 
mobile unit. Either the Enhanced Private Conversa-
tion™ or Private Conversation II™ modes may be 
programmed depending on the capabilities of the radio 
system. Operation in the Enhanced Private Conversa-
tion mode is described in the following information, 
and operation in the Private Conversation II mode is 
described in Section 2.5.5. 

The Private Call option switch is required to 
place these calls, and either that switch or the Call 
Response option switch is required to receive them. 
Proceed as follows. 

Placing an Enhanced Private Conversation Call

This call is initiated by selecting the unit ID from 
a call list (list entry) or by directly entering it using the 
microphone keypad (direct entry). Proceed as follows:

List Entry Method

1. With a SMARTNET/SmartZone channel selected, 
momentarily press the Private Call option switch. 
The private call mode is then indicated by “C” in the 
upper part of the display. Then if the last ID called 
matches an ID in your call list, it is displayed on the 
lower line and the name is displayed on the upper 
line. Otherwise, only the last ID called is displayed.

2. Scroll through the private call list by rotating the 
Select switch until the desired ID is displayed. To 
cancel the call, press the Private Call switch.

3. Press the PTT switch to initiate the call. The display 
then indicates the alias of the destination radio. 
Proceed to the bulleted list following the next 
method for conditions that may occur next.
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Direct Entry Method (With DTMF Microphone Only)

1. With a SMARTNET/SmartZone channel selected, 
press and hold the Private Call option switch until a 
tone sounds (approximately 1 second). The last ID 
called is displayed on the upper line, and the private 
call mode is indicated by “C” in the upper part of the 
display.

2. Using the 0-9, #, and * keys, enter the 6-digit ID of 
the mobile unit you are calling. To erase the last 
digit entered, rotate the Select switch counterclock-
wise, and press the Private Call switch to cancel the 
call.

3. Press the PTT switch to initiate the call. If the 
entered ID is invalid, “INVALID” is momentarily 
displayed and the call is not initiated. If the entered 
ID is valid, the alias of the ID is displayed on the 
lower line if it matches an ID in your call list. Other-
wise, only the ID you entered continues to be 
displayed. Any of the following conditions may 
then occur:

• If the radio you are calling is on the air, telephone 
type “ringing” is heard for 20 seconds or until the 
called party answers. 

• If the called party answers and the call is 
successful, the person’s voice is heard and the call 
is carried on the same as a group call. To end the 
call at any time, press the Private Call switch. 

• If the called party does not answer within 20 
seconds, “NO ANSWR” is displayed and a contin-
uous tone sounds. End the call by pressing the 
Private Call switch. 

• If the called radio is not in service, no ringing is 
heard, “NO ACK” is displayed, and a continuous 
tone sounds. End the call by pressing the Private 
Call switch.

• If neither your radio nor the radio being called is 
authorized to make unit-to-unit calls, “NO ACK” 
is displayed and a continuous tone sounds. End the 
call by pressing the Private Call switch.

• If the called party answers but the radio system is 
busy, four low tones sound and “BUSY” is 

displayed. When the system is no longer busy, the 
called party automatically responds.

• If an out-of-range condition exists or the radio 
system is not in service, “NO SYS” is displayed 
and a continuous tone sounds. End the call by 
pressing the Private Call switch.

Receiving an Enhanced Private Conversation Call

This call is automatically received if a 
SMARTNET/SmartZone channel is selected. Proceed 
as follows:

1. When this call is received, a recurring unit call tone 
(three beeps) sounds for up to 20 seconds and 
“CALL RCV” is displayed on the lower line. 

2. To answer the call, press the Private Call option 
switch and then the PTT switch and begin talking. 
The private call mode is indicated by “C” in the 
upper part of the display, and the alias of the 
incoming call is displayed if the ID is in your call 
list. Otherwise, the unit ID is displayed. NOTE: If 
the Private Call option switch is not pressed before 
the PTT switch, a group call is transmitted on the 
selected group.

• To end the call when the conversation is complete 
or at any other time, press the Private Call switch.

• If private calls are not permitted (Private Call 
switch not programmed), press the Call Response 
option switch, if available, to answer the call. 

• If the call is not answered within 20 seconds, it is 
automatically terminated.

• If the radio system is busy, four low tones sound 
and “BUSY” is displayed. When the system is no 
longer busy, the call back tone (four beeps) is 
heard and your radio automatically starts transmit-
ting. Press the PTT switch to continue the call.

• To ignore an incoming call, wait 20 seconds until 
the recurring unit call tone stops sounding. 
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2.5.5 PRIVATE CONVERSATION II CALLS

General

Private calls allow you to place a call to a specific 
mobile unit. Either the Enhanced Private Conversa-
tion™ or Private Conversation II™ modes may be 
programmed depending on the capabilities of the radio 
system. Operation in the Enhanced Private Conversa-
tion mode is described in Section 2.5.4, and operation 
in the Private Conversation II mode is described in the 
following information.

The Private Call option switch is required to 
place these calls, and either the Private Call or Call 
Response option switch is required to receive them. 
Proceed as follows. 

Placing a Private Conversation II Call

This call is initiated by selecting the unit ID from 
a call list (list entry) or by directly entering it using the 
microphone keypad (direct entry). Proceed as follows:

List Entry Method

1. With a SMARTNET/SmartZone channel selected, 
momentarily press the Private Call option switch. 
The private call mode is indicated by “C” in the 
upper part of the display, and the alias (name) of the 
last ID called is displayed if it matches an ID in your 
call list. Otherwise, the last ID called is displayed.

2. Scroll through the private call list by rotating the 
Select switch until the desired ID is displayed. Press 
the Private Call switch again to cancel the call.

3. Press the PTT switch to initiate the call. The display 
then indicates the alias of the destination radio. Wait 
approximately 1 second and then begin talking. 
Proceed to the bulleted list following the next 
method for conditions that may occur next.

Direct Entry Method (With DTMF Microphone Only)

1. With a SMARTNET/SmartZone channel selected, 
press and hold the Private Call option switch until a 
tone sounds (approximately 1 second). The last ID 
called is displayed on the upper line, and the private 
call mode is indicated by “C” in the upper part of the 
display.

2. Using the 0-9, #, and * keys, enter the 6-digit ID of 
the mobile unit you are calling. To erase the last 
digit entered, rotate the Select switch counterclock-
wise, and press the Private Call switch to cancel the 
call.

3. Press the PTT switch to initiate the call. If the 
entered ID is invalid, “INVALID” is momentarily 
displayed and the call is not initiated. If the entered 
ID is valid, the alias of the ID is displayed on the 
lower line if it matches an ID in your call list. Other-
wise, only the ID you entered continues to be 
displayed. Wait approximately 1 second and begin 
talking. Any of the following conditions may then 
occur:

• If the called party answers and the call is 
successful, the person’s voice is heard and the call 
is carried on the same as a group call. To end the 
call at any time, press the Private Call switch.

• If the radio system is busy, four low tones sound 
and “BUSY” is displayed. When the system is no 
longer busy, the call back tone (four beeps) is 
heard and a channel is automatically acquired. 
Press the PTT switch to continue the call.

Receiving a Private Conversation II Call

Private calls are automatically received if a 
SMARTNET/SmartZone channel is selected. Proceed 
as follows:

1. When a call is received, an alert tone sounds and the 
caller’s voice is heard. While voice is heard, “C” is 
indicated in the upper part of the display and “CALL 
RCV” is displayed and the lower line of the display. 

2. To answer the call, press the Private Call option 
switch and then the PTT switch and begin talking. 
The private call mode is indicated by “C” in the 
upper part of the display, and the alias of the 
incoming call is displayed if the ID is in your call 
list. Otherwise, the unit ID is displayed. NOTE: If 
the Private Call option switch is not pressed before 
the PTT switch, a group call is transmitted on the 
selected group.

• To end the call when the conversation is complete 
or at any other time, press the Private Call option 
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switch again. If the call is not answered within 20 
seconds, it is automatically terminated.

• If private calls are not permitted (Private Call 
switch not programmed), press the Call Response 
option switch, if available, to answer the call. 

2.5.6 TELEPHONE CALLS

General

Telephone calls allow you to place and receive 
calls over the public telephone system using your 
transceiver. If your transceiver is programmed for tele-
phone calls (Phone option switch programmed), they 
are placed and received as follows:

Placing a Telephone Call

Telephone calls can be placed by selecting the 
number from a preprogrammed phone number list (list 
entry) or by directly entering it using the microphone 
keypad (direct entry). Proceed as follows:

List Entry Method

1. With a SMARTNET/SmartZone channel selected, 
momentarily press the Phone option switch. The 
phone mode is indicated by the  icon, and the 
display indicates the alias of the last called tele-
phone number if it is in your phone number list. 
Otherwise, the last called telephone number is 
displayed.

2. Scroll through the list of telephone numbers by 
rotating the Select switch until the desired number is 
found. Press the Phone option switch again to cancel 
the call.

3. Press the PTT switch to initiate the call. The display 
indicates “DIALING” while the connection to the 
phone system is occurring. Once connected, the 
normal dial tone is heard and the alias of the number 
being called is again displayed. The radio then auto-
matically dials the telephone number and the normal 
ringing or busy tone is heard. Proceed to the bulleted 
list following the next method for conditions that 
may occur next.

Direct Entry Method (With DTMF Microphone Only)

1. With a SMARTNET/SmartZone channel selected, 
press and hold the Phone option switch until a tone 
sounds (approximately 1 second). The last phone 
number called is displayed, and the phone mode is 
indicated by the  icon.

2. Enter the number using the 0-9, , and # keys. To 
enter a pause (indicated by “P”), press  and then 
#. The number scrolls to the left in the display so 
that the seven right-most digits are always 
displayed. Numbers up to 16 digits (including 
pauses) can be entered. To erase the last digit 
entered, rotate the Select switch counterclockwise, 
and press the Phone switch to cancel the call.

3. Press the PTT switch to initiate the call. The display 
indicates “DIALING” while the connection to the 
phone system is occurring. Once connected, the 
normal dial tone is heard and the alias of the number 
being called is again displayed. The radio then auto-
matically dials the telephone number and the normal 
ringing or busy tone is heard. Any of the following 
conditions may then occur.

• After the called party answers, press the PTT 
switch to talk and release it to listen. You cannot 
talk and listen at the same time because the radio 
cannot transmit and receive at the same time. Each 
time the PTT switch is released, a tone is heard by 
the other party that indicates when a response can 
be made. To end the call when the conversation is 
complete or at any other time, press the Phone 
option switch again.

• If equipped with an optional DTMF microphone, a 
number can be dialed during a call.

• If an out-of-range condition exists or the radio 
system is not in service, “HANG UP” is displayed 
and a continuous tone sounds. End the call by 
pressing the Phone option switch.

• If you are not authorized to make telephone calls, 
“REJECT” is displayed and a continuous tone 
sounds. End the call by pressing the Phone option 
switch.

* *
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• If the radio system is busy, “BUSY” is displayed 
and a busy tone sounds. The call automatically 
proceeds when the radio system becomes avail-
able. If the call is ended before it proceeds, your 
position in queue is lost.

Answering a Telephone Call

Telephone calls are automatically received if a 
SMARTNET/SmartZone channel is selected. Proceed 
as follows:

1. When a telephone call is received, “ringing” similar 
to a standard telephone is heard, and the display 
indicates “PHONE” on the bottom line.

2. To answer the call, press the Phone option switch 
and the phone mode is indicated by the  icon. 
Press the PTT switch to talk and release it to listen. 

3. To end the call when the conversation is complete or 
at any other time, press the Phone option switch 
again. 

2.5.7 CALL ALERT 

The Call Alert™ feature allows pages to be sent 
and received as follows:

Sending a Page

1. With a SMARTNET/SmartZone channel selected, 
momentarily press the Call Alert option switch. The 
tag (alias) of the last ID called is displayed if it 
matches an ID in your call list. Otherwise, the last 
ID called is displayed.

2. To select the desired ID, rotate the Select switch to 
scroll through the ID list. Press the Call Alert option 
switch again to cancel the call.

3. Press the PTT switch to send the page. The display 
then indicates the alias of the radio being paged. 
Conditions that may then occur are as follows:

• If the radio you are paging is on the air and 
received your page, a signaling success tone (six 
beeps) sounds and the display momentarily indi-
cates “ACK RCVD” on the bottom line. The alias 

of the selected channel is then displayed 
continuously. 

• If the radio you are paging is not in service, a tone 
sounds and “NO ACK” is displayed. Press the Call 
Alert switch again to cancel the page.

Answering a Page

1. When a page is received, “PAGE RCV” is indicated 
on the bottom line and a recurring received page 
tone (six beeps) sounds. 

2. Answering a page is the same as placing a private 
call. Therefore, press the Private Call option switch 
and follow the instructions for placing a private call 
in Section 2.5.4 or 2.5.5, whichever is applicable.

2.5.8 MESSAGING

The messaging feature allows preprogrammed 
messages to be sent to your dispatcher. Up to 16 
messages can be preprogrammed, and they are identi-
fied by alias (name). If a Message option switch is 
programmed, messages are sent as follows:

1. Momentarily press the Message option switch. The 
alias of the last message sent is displayed.

2. Scroll through the message list by rotating the Select 
switch until you find the desired message. Press the 
Message option switch again to cancel the message.

3. Press the PTT switch to send the message. When the 
message is received and acknowledged by the 
dispatcher, a signaling success tone (six beeps) 
sounds and the display returns to the normal channel 
indication. If there is no acknowledgment after 6 
seconds, a tone sounds and “NO ACK” is displayed. 
Press the Message option switch again to return to 
normal operation.

2.5.9 SENDING STATUS CONDITIONS

The status feature allows you to send your current 
status to a dispatcher. Up to eight status conditions can 
be preprogrammed, and they are identified by an alias 
(name). If the Status option switch is programmed, 
status conditions are sent as follows:
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1. Momentarily press the Status option switch, and the 
alias of the last status sent is displayed.

2. To change the displayed status, scroll through the 
status list by rotating the Select switch. Press the 
Status option switch again to cancel this function. 

3. Press the PTT switch to send the status. When the 
message is received and acknowledged by the 
dispatcher, a signaling success tone (six beeps) 
sounds and the display returns to the normal channel 
indication. If there is no acknowledgment after 6 
seconds, a tone sounds and “NO ACK” is displayed. 
Press the Status option switch again to return to 
normal operation.

2.5.10 EMERGENCY ALARM AND CALL

Introduction

Emergency Alarms and Emergency Calls are 
separate functions that can be individually enabled or 
disabled on each SMARTNET/SmartZone system. 
The Emergency option switch is also required for 
these functions, and it is always the button to the left 
of the display when it is used. Emergency Alarms and 
Calls are transmitted on the emergency talk group 
programmed on the selected system. 

Emergency Alarms

An emergency alarm is a special data transmis-
sion that alerts a dispatcher of an emergency situation. 
Proceed as follows to activate an emergency alarm: 

1. Select a SMARTNET/SmartZone channel that has 
this feature enabled and then press the Emergency 
option switch. The radio then begins automatically 
transmitting an emergency alarm data message and 
“EMERGNCY” is indicated in the display for 3 
seconds.

2. When the emergency alarm is acknowledged, the 
emergency acknowledge tone (two beeps) sounds. 
Silent operation may also be programmed in which 
case no tone sounds and there is no indication that 
an acknowledgment occurred.

3. The radio continues to transmit this message until an 
acknowledgment is received or the programmed 

number of attempts have been made. To exit this 
mode, power must be turned off and then on again. 

Emergency Calls

An emergency call urgently requests access to a 
voice channel. To place this call, proceed as follows: 

1. Select a SMARTNET/SmartZone channel that has 
this feature enabled and press the Emergency option 
switch. The emergency mode is indicated when 
“EMERGNCY” is indicated in the display for 
3 seconds. 

2. To place the emergency call, manually press the 
PTT switch and begin speaking as with a standard 
call. All group calls which follow are then emer-
gency calls (private, telephone, and call alert calls 
are not allowed). If the channel is changed, the call 
is made on the emergency talk group programmed 
for the new channel.

3. To exit this mode, power must be turned off and then 
on again.

2.5.11 FAILSOFT OPERATION

If a failure occurs in the SMARTNET/Smart-
Zone system so that it cannot be used, the transceiver 
automatically enters the failsoft mode. When this 
mode is selected, “FAILSOFT” is indicated on the 
lower line of the display.

When in the failsoft mode, operation is in the 
conventional mode on a preprogrammed failsoft 
channel. If a transmission is attempted before a failsoft 
channel is located, a continuous tone sounds until the 
PTT switch is released. When the radio system returns 
to normal operation, this condition is automatically 
detected and normal operation resumes. 

2.5.12 SMARTNET/SMARTZONE SCANNING

Scanning on a SMARTNET/Smartzone channel 
is similar to the standard and radio wide scanning 
described starting in Section 2.3.11. Each channel can 
be programmed with a different scan list that includes 
up to 16 channels, one of which can be a priority 
channel. Up to three lists can be programmed, and 
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they are user programmable if the Scan Edit option 
switch is programmed (see “Programing a Scan List” 
in Section 2.3.11).

Scanning is enabled/disabled by the Scan option 
switch. In addition, channels can be programmed so 
that scanning automatically starts whenever the 
channel is selected. Scanning is temporarily disabled 
and “S” turns off if a channel is selected that has scan-
ning disabled. Then when a channel is selected again 
that permits scanning, it is automatically re-enabled. 

When responding to messages in the scan mode, 
programming determines if the response always 
occurs on the talk group of the call or the selected talk 
group (if they are different). Transmissions occurring 
at other times always occur on the selected talk group.

In addition to calls on channels in the scan list, 
pages, private calls, and telephone calls are received 
while scanning. Messages on the priority channel are 
received while listening to lower priority messages. 
However, private and telephone calls are not inter-
rupted by calls on the priority channel. 

2.5.13 DYNAMIC REGROUPING

The dynamic regrouping feature allows a 
dispatcher to switch users to a dynamically defined 
channel to receive an important message. Dynamic 
regrouping operates as follows:

1. When this command is received, the alternating 
dynamic regrouping tone sounds, the transceiver 
automatically changes to the regrouping channel, 
and the display indicates “REGROUP” on the lower 
line. All transmitting and receiving then occurs on 
this channel. 

2. To reset all talk and announcement groups to normal 
so that only the designated regrouping channel is on 
the dynamic group, manually select the designated 
regrouping channel if you know it. If this channel is 
not selected or there is no designated regrouping 
channel, all transmissions occur on the dynamically 
assigned group regardless of which channel is 
selected, and the regrouping tone sounds each time 
the PTT switch is pressed. 

3. When regrouping is canceled by the dispatcher, 
transceiver operation returns to normal. 

2.5.14 SMARTZONE FEATURES

Introduction

As described in Section 2.3.12, the SmartZone® 
mode provides wide area coverage by allowing 
roaming between SMARTNET and conventional sites. 
SmartZone operation is the same as SMARTNET with 
the following additional features:

Determining Current Site

To determine the current radio site, momentarily 
press the Site Search option switch (if programmed). If 
currently registered on a site, “SITE x” is displayed on 
the top line, where “x” is the site number. If the site is 
locked (see following), “LOCK x” is displayed 
instead. The RSSI (Receive Signal Strength Indicator) 
value of the current site as “RSSI x” is displayed on 
the bottom line as “RSSI x”. To exit, press the Site 
Search switch again.

Searching For a New Site

Press the Site Search option switch as described 
above. Then to scroll through the other programmed 
sites, rotate the Select switch while “SITE x” or “RSSI 
x” is displayed. To select the displayed site, press the 
Site Search option switch. To exit this mode and return 
to normal operation, press the Site Search switch 
again. If site lock is on when site search is entered (see 
following), the radio will be locked on the new site 
when this function is exited. 

Locking/Unlocking a Site

It is sometimes desirable to stay on the current 
site regardless of signal level. To lock the radio on the 
current site so that it does not search for another, press 
the Site Lock option switch (if programmed). The 
display then momentarily indicates “LOCK x” to indi-
cate that the current site is locked (“x” is the current 
site number). To unlock the site, press the Lock switch 
again and “UNLOCK” is momentarily displayed. 
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When locked on a site, it is still possible to search 
for a different site using the site search function 
described in the preceding section. When a new site is 
found, the radio is then locked on that site.

2.6 SUPERVISORY TONES 

Single Beep (Alert Tone)

• Power was turned on and a successful power-up 
sequence occurred (Section 2.3.2).

• The time-out timer is about to expire or the penalty 
timer has expired (Sections 2.3.7 and 2.4.7).

• The conversation timer is about to expire (Section 
2.4.8). 

• The system received your page but the paged mobile 
is not on the air (Section 2.5.7).

• Telephone interconnect is not operational (Section 
2.5.6).

Continuous Tone (Invalid or No Acknowledge 
Condition)

• A transmission is being attempted on an unpro-
grammed channel or a conventional channel 
programmed as receive-only.

• The transmitter is disabled by the busy channel 
lockout feature (Section 2.4.5).

• The transmitter has been disabled by the time-out 
timer feature (Section 2.3.7).

• The transmitter has been disabled by the conversa-
tion timer (Section 2.4.8).

• An out-of-range condition exists (SMARTNET/
SmartZone only).

• A transmission is being attempted before the penalty 
timer has expired (Section 2.4.7).

• Dynamic regrouping has been exited but the 
dynamic regrouping channel is still selected 
(Section 2.5.13).

• The paged mobile did not acknowledge the page 
(Section 2.5.7).

• The message that was sent has not been acknowl-
edged (Section 2.5.8).

• The status condition that was sent has not been 
acknowledged (Section 2.5.9).

Single Short Medium-Pitch Tone

• A valid key has been pressed.

Single Short Low-Pitch Tone

• An invalid key has been pressed.

Six Beeps (Recurring)

• The page was received (Section 2.5.7).

Three Beeps (Recurring)

• A unit-to-unit call was received (Section 2.5.4).

Six Beeps

• The paged radio received the page and acknowl-
edged it (Section 2.5.7).

• The message that was sent has been received and 
acknowledged (Section 2.5.8).

• The status condition that was sent has been received 
and acknowledged (Section 2.5.9).

Two Beeps

• The emergency alarm condition was acknowledged 
(Section 2.5.10).

Gurgle-Like Tone

• Dynamic regrouping has occurred (Section 2.5.13).
• Dynamic regrouping has occurred but the 

regrouping channel is not selected (Section 2.5.13).

Four Low Tones (Busy Signal)

• The radio system is busy or a busy condition exists 
when making a telephone call.

Four Alternating High and Low Tones

• A channel is available after a busy condition 
occurred (SMARTNET/SmartZone only).
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SECTION 3   PROGRAMMING
Figure 3-1   Programming Setup
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3.1 GENERAL

3.1.1 PROGRAMMING SETUP

The following items are required to program the 
transceiver and control unit. The part numbers of this 
equipment are shown in Table 1-1 in Section 1. The 
programming set-up is shown above.

• IBM® PC or compatible personal computer
• Remote Prog. Interface (RPI) P.N. 023-9800-000
• Cables from the RPI to the computer and 

transceiver
• E.F. Johnson PCTrunk programming software.

3.1.2 COMPUTER DESCRIPTION

The computer used to run this program should 
meet the following minimum requirements:

• Windows® 3.1, 95/98, or NT 3.51 (Windows NT/
2000 is supported only by PCTrunk Version 5.10.0 
or later)

• Intel® 486 processor or equivalent
• At least 4 MB of RAM

• A hard disk drive with at least 5 MB of free space
• A CD-ROM drive
• An available serial port

NOTE: With the descriptions which follow, it is 
assumed that you have a basic understanding of how 
to use your Windows-based operating system. If you 
are not familiar with some of the Windows functions 
described, refer to your Help Screens and manuals 
included with your Windows software.

3.1.3 PCTRUNK SOFTWARE INSTALLATION

The PCTrunk software is supplied on a CD-
ROM. Install this software as follows:

1. Make sure that there are no other Windows applica-
tions open during this installation procedure. Also, 
make sure that the computer meets the minimum 
requirements listed in the preceding section.

2. Insert PCTrunk CD-ROM in the CD drive of your 
computer.
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3. Windows 3.1 - In the Program Manager, double 
click the SETUP.EXE file on the CD-ROM or click 
that file name and select File > Run.

Windows 95/98/NT - In the bottom left corner of 
the screen, select Start > Run and then click the 
Browse button in the window that is displayed. 
Then in the “Look In:” pull-down menu, select the 
CD-ROM drive and the file “Setupxx.x.exe”. Click 
the open button and then from the Run window, 
click OK and the installation process begins. (The 
“xx.x” in the filename is the version of PCTrunk 
being loaded.) 

4. Follow the instructions displayed by the setup 
program. The default directory for the program is 
\Program Files\PCTrunk. If you wish to use some 
other directory, click Browse and select it or type the 
name.

3.1.4 CONNECTING RPI TO COMPUTER AND 
TRANSCEIVER

RPI Information

The RPI provides the required interface between 
the computer and transceiver. It converts the RS-232 
logic levels from the computer to the TTL logic levels 
required by the transceiver microprocessor and vice 
versa. 

A new RPI (Part No. 023-9800-000) has been 
designed for this transceiver. This RPI is backward 
compatible, so it can also be used to program other 
E.F. Johnson transceivers which require an RPI (except 
the 5300 series). This new RPI is required to Flash 
program the transceiver to update the logic board oper-
ating software, and it has a phone jack that is required 
for injecting the transmit audio signal during align-
ment. To perform the standard personality program-
ming described in most of this section, earlier RPI’s 
such as Part No. 023-5810-000 or 023-9750-000 can 
also be used.

When programming both front and remote models 
of this transceiver, the switch on the front panel of the 
RPI selects either the standard or Flash programming 
mode. The standard mode is selected when it is away 
from the LED and the indicator is green, and the Flash 
mode is selected when it is toward the LED and the 

indicator is amber. The standard mode should be 
selected for all but Flash programming. 

With some remote mount transceivers (not 9800 
series), this switch is used to turn transceiver power on 
and off. A separate 9-16 VDC, 200 mA power supply 
(such as P.N. 563-0001-005) must then be plugged into 
the RPI power jack to provide power to the RPI. 

Cable Information

The cables from the RPI to the computer and 
transceiver are not included with the RPI. The -9800- 
RPI has a female DB9 connector for the computer 
connection. Since most computer serial ports have a 
male DB9 or DB25 connector, a male DB9 to female 
DB9 or DB25 is usually required. This is a standard 
cable available at most computer supply stores. A suit-
able cable is also listed in Table 1-1.

The cable from the RPI to the transceiver has 
modular telephone-style connectors on each end. It 
plugs into the microphone jack on the front panel of 
the transceiver. The cable for this application is also 
listed in Table 1-1.

3.1.5 STARTING AND EXITING

To Start PCTrunk From Windows 3.1

In the Program Manager, open the PCTrunk group 
window. Then double-click the PCTrunk icon.

To Start PCTrunk From Windows 95/98

Click the Start button and select the PCTrunk 
group. Then double-click the PCTrunk icon.

To Exit PCTrunk:

Select File > Exit or press ALT + F4.

3.1.6 PROGRAMMING FILE TYPES

Programming data is stored in a disk file that can 
be saved, read, copied, and deleted (see Section 3.3.1). 
The file that is stored for each programming session 
has the .DAT extension.
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Figure 3-2   Main Screen (Later PCTrunk Versions)
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3.1.7 HELP FILES

To display help information on the current screen, 
click Help in the menu bar or press F1.

3.1.8 SCREEN GROUPS

General

The following screen groups are displayed:

Radio-Wide - These screens program parameters that 
are the same for all systems and channels. Separate 
screens are displayed for General, Conventional, 
SMARTNET/SmartZone, and Mobile Options param-
eters. Refer to Section 3.4 for more information on 
these screens. 

System - These screens program the parameters that 
are unique to the displayed Conventional, 
SMARTNET, or SmartZone system. The system to be 
edited is selected as described in Section 3.1.11.

Channel - This screen programs unique channel 
parameters and assigns channels to each zone. The 
specific parameters indicated in this screen are deter-
mined by the type of system selected in the “Type” 
box (Conventional, SMARTNET, SmartZone). 

3.1.9 DISPLAYING SCREENS

The latest release of PCTrunk uses a different 
method of displaying screens. Proceed as follows to 
select which screens are displayed with the different 
versions: 

Revised PC Trunk (Version 5.10.0 or Later)

Revised versions of PCTrunk use a pane on the 
left side of the screen (see Figure 3-2) to display the 
screen structure similar to the directory structure of a 
hard drive. Click the “+” to expand the branch and “–” 
to collapse it. Then to display a screen, simply click its 
name. The current screen may have to be closed in 
order to select another one.

Early PCTrunk (Versions Prior to 5.10.0)

With early versions of PCTrunk, the screens are 
displayed in cascade style or they can be minimized 
like any Windows screen. To cascade the active 
screens, select Window > Cascade from the menu bar. 

To pop a screen to the front, click the applicable 
button which follows. For example, if the Channel 
screen is displayed and you want to quickly pop the 
Radio-Wide screen to the front, click the Radio-Wide 
button. These buttons can be displayed or hidden by 
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clicking Window > Toolbar. A window can also be 
displayed by selecting it in the Window Menu. 

Screen Pop-Up Buttons
(Early PC Trunk Versions)

3.1.10 FILE SIZE INDICATOR

The maximum number of channels that can be 
programmed may be limited by the available memory 
space in the radio (see Section 1.5.3). A running indi-
cation of the amount of memory used by the current 
data (if it was downloaded to the radio) is displayed by 
a bar graph as shown in Figure 3-2 and the preceding 
illustration. When the bar reaches the right end, avail-
able memory is full and some channels may need to be 
deleted to program more information.

3.1.11 CREATING AND DISPLAYING 
SYSTEMS

To create a new SMARTNET or SmartZone 
system, select Systems > Add Systems and then the 
desired system type from the menu bar (see Section 
3.3.5). This menu is also used to delete a system. 

NOTE: Only one conventional system can be set up, 
and it is automatically created when a new file is 
created as described in Section 3.3.1. Therefore, there 
is no option to add a conventional system.

Only one system can be displayed at a time, so 
select the system to be edited as described in the 
preceding section. Systems are indicated by number 
and type. Channels and talk groups for all programmed 
systems are set up in the Channels screen. Therefore, 
any channel can be selected when programming 
channel information. 

3.2 PROGRAMMING PROCEDURE

The following is a general procedure you can use 
to program a transceiver.

3.2.1 PRELIMINARY

1. Select a programming file as follows:

Create a New File - To start with a new file 
containing default parameters, select File > New 
and then the frequency band of the radio (VHF/
UHF/800 MHz). 

Open An Existing File - To open an existing file 
stored on disk, select File > Open and then the file 
to be opened.

Upload a File From a Radio - To transfer a file 
from a radio to the computer to edit or use as a 
basis to program another radio, connect the radio to 
the computer as described in Section 3.1.4. Then 
turn the radio on and select Upload from the menu 
bar. 

2. Before or after creating the programming file, be 
sure the correct type (98xx mobile) is selected by the 
Radio Type menu (see Section 3.3.2).

3. A conventional system is automatically set up when 
a new programming file is created. If SMARTNET 
or SmartZone systems are also to be programmed, 
set them up as described in Section 3.1.11.

3.2.2 PROGRAMMING RADIO WIDE 
PARAMETERS

1. To display the Radio Wide screens, click the screen 
name under Radio Wide in the left pane or click the 
Radio Wide button (see Section 3.1.9).

2. Program the applicable information in these screens 
as described in Section 3.4.

3.2.3 PROGRAMMING CONVENTIONAL 
CHANNELS

NOTE: If no conventional channels are programmed, 
skip this section.

1. Make sure the conventional system is displayed by 
clicking it in the left pane or selecting Window > 
Conventional in the menu bar.
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2. If required, display the Conventional System 
programming screens by clicking the System button 
or selecting Window > Conventional System (see 
Section 3.1.9).

3. Program the conventional systems and channels as 
described in Section 3.5.

3.2.4 PROGRAMMING SMARTNET AND 
SMARTZONE SYSTEMS

NOTE: If no SMARTNET or SmartZone systems are 
programmed, skip this section.

1. Make sure the desired SMARTNET or SmartZone 
system is displayed by clicking it in the left pane or 
selecting Window > SMARTNET or SmartZone in 
the menu bar.

2. If required, display the screens for that system by 
clicking the System button or selecting Window > 
Desired System (see Section 3.1.9).

3. Program the SMARTNET/SmartZone system and 
talk groups as described in Section 3.6. 

4. To program additional SMARTNET/SmartZone 
systems, add a new system as described in Section 
3.1.11 and repeat Section 3.6.

3.2.5 PROGRAMMING RADIO 
(DOWNLOADING FILE)

When all the required programming information 
has been entered in the various programming screens, 
the information can be programmed (downloaded) into 
the radio. When downloading a file, be sure that all 
connections between the computer and radio are 
secure, the radio is turned on, and the proper serial 
port is selected (see Section 3.3.1). 

Then select Download > Parameters to 98xx 
Mobile. If no file is currently loaded, a dialog box 
appears to select the desired file. If a file is already 
loaded when Download is selected, the current file is 
transferred to the radio.

NOTE: The information which follows (Sections 3.3- 
3.6) provides detailed descriptions of the parameters 
that are displayed in the various PCTrunk screens.

3.3 MENU COMMANDS

Menu Bar

3.3.1 FILE MENU

New - Creates a programming file with default param-
eters for the selected frequency range.

Open - Opens a programming file that was previously 
saved to disk. If a modified file is currently open, you 
are asked if that file should be saved before the new 
file is opened.

Close - Closes the current file. If the file has been 
modified and the changes have not been saved, you are 
asked if the changes should be saved before closing.

Save - Saves the current file to disk using the current 
file name.

Save As - Same as “Save” except you are prompted to 
enter a new file name if desired.

Print - Prints the information in the current file. 

Select Communications Port - Displays the Commu-
nications Port dialog box which is used to select the 
serial port that is used to connect the transceiver to the 
computer (see Section 3.1.4).

Exit - Closes the PCTrunk program. If the current file 
has been modified and the changes have not been 
saved, you are asked if the changes should be saved 
before closing.
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3.3.2 RADIO SERIES MENU

The Radio Series menu show above selects the 
radio type (9883 Mobile) being programmed.

3.3.3 DOWNLOAD MENU

Parameters to 98xx Mobile - Transfers the current 
programming file to the radio connected to the 
computer. 

DSP Code to 98xx Mobile - This function along with 
a special DSP upgrade file from E.F. Johnson are used 
to upgrade the DSP firmware. To put the radio in 
download mode, power the radio off, temporarily 
connect the microphone, and power it back on while 
pressing the microphone PTT switch. The DSP down-
load mode is then indicated by “CODE” in the display. 
The microphone is then disconnected, the RPI 
connected, and the code downloaded. 

3.3.4 UPLOAD MENU

The Upload Menu is displayed only in the 
opening screen before a programming file is created. 
The following options are displayed:

Parameters from 98xx Mobile - Transfers the 
programming data from a radio to the PCTrunk 
program. This data can then be viewed, edited, or 
saved to a disk file as desired.

Version Information from 98xx Mobile - Displays 
the software version number and serial number of the 
connected radio.

3.3.5 SYSTEMS MENU

The Systems Menu is used to create new 
SMARTNET and SmartZone systems. It is also used 
to delete current systems. Conventional systems 
cannot be added because only one can be created. 
Refer to Section 3.1.11 for more information.

3.3.6 TOOLS MENU

The Tools > Convert File Format function is not 
used with this transceiver. It converts Format 5.4 files 
to the 5.5 format. All 98xx models use Format 5.5.

3.3.7 WINDOW MENU

The Window Menu is used to select the system to 
be edited. It can also be used to pop one of the screens 
to the front. Refer to Section 3.1.9 for more
information.

3.3.8 HELP MENU

Contents - Displays the help system table of contents.

Search For Help On - Displays the search dialog box 
that allows searching for a help topic by keyword.

About PCTrunk - Displays the software version 
number of PCTrunk and other information.
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3.4 RADIO-WIDE PARAMETER SCREENS

3.4.1 INTRODUCTION

The radio-wide screens program the parameters 
that are the same for all systems, channels, and zones. 
Separate screens are used for General, Conventional, 
SMARTNET/SmartZone, and Mobile Options param-
eters. Refer to the information which follows.

3.4.2 RADIO-WIDE GENERAL SCREEN

Band

Displays the operating band selected by the Radio 
Type Menu (see Section 3.3.2). The selected oper-
ating band must match that of the radio being 
programmed. 

Zones

Total Zones - The total number of zones currently set 
up. The maximum number allowed is 16. Zones are 
added by clicking the Add button (see following).

Current Zone - Indicates the currently selected zone. 
To select another zone, click the up/down arrows.

Zone Alias - Edits the unique alpha identification 
for the displayed zone. Up to 8 characters can be 
entered. The zone alias is briefly displayed when-
ever a new zone is selected. Refer to Section 1.5.3 
for more information on zones.

Add (Zones) Button - Adds another zone.

Delete (Zones) Button - Deletes the last zone added.

Defaults

Home Zone - Selects the zone that is selected by the 
Home Zone option switch if programmed.

Options

Power-Up On Home Zone - If checked, the home 
zone is always selected at power-up.

Beeps - If checked, all tones are enabled. Otherwise, 
no tones sound (see Section 2.3.8).

NOTE: With PCTrunk, Version 5.10.0 or later, the 
following screens are selected by clicking their name 
in the left pane, not by clicking the button in the 
General screen.

 Radio Wide Scan List

NOTE: The radio-wide scan list cannot be pro-
grammed until all channels to be included have been 
set up as described in the Conventional and 
SMARTNET/SmartZone sections (3.5 and 3.6,
respectively).

Clicking the Radio Wide Scan List name in the 
left pane or that button in the General screen displays 
the following screen which programs the radio-wide 
scan list described in Section 2.3.11. The buttons and 
other parameters in this screen are as follows:

Radio-Wide Scan List Screen
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 Button - Displays the following 
screen that selects the channels in each Zone and 
System that are in this scan list. Select each Zone 
and then the channels to be included from that zone. 

Delete Entry - Deletes the selected channel from the 
scan list.

Scan Hold Time - This programs the delay that 
occurs before radio-wide scanning resumes after a 
message is no longer being received. Times of 
0 - 7.5 seconds can be programmed (see Section 
2.3.11).

Modify List Screen

 Assign Function Buttons

Clicking “Assign Functions Buttons” in the left 
pane or that button in the General screen displays the 
following screen which programs the five front panel 
option switches. These switches can be programmed 
with a different set of functions for each operating 
mode (conventional and SMARTNET/SmartZone). 
Refer to Section 2.3.4 for more information. 

Program the option switches as follows:

1. In the System Type pull-down menu, select the 
mode to be programmed (either conventional or 
SMARTNET/SmartZone).

Assign Function Buttons Screen

2. To program a switch, click the arrow to display the 
pull-down menu and then select the desired function 
from that menu. 

3. Repeat for all switches and modes to be 
programmed and then exit this screen by clicking 
the Close button.

3.4.3 RADIO-WIDE CONVENTIONAL SCREEN

The radio-wide conventional screen is shown 
above, and it is used to program the DTMF ANI ID. 
This ID is used on channels programmed for pre- or 
post-transmit ANI (see Section 3.5.4) and consists of 
eight digits from 0-9.

3.4.4 RADIO-WIDE SMARTNET/SMARTZONE 
SCREEN

The radio-wide SMARTNET/SmartZone screen 
is shown on the next page, and it is used to program 
the following parameters:

Full Spectrum CC Scan

In a SmartZone system, if all potential control 
channel frequencies have been searched, the radio 
enters a channel-by-channel search across the full 
spectrum that the radio covers. The timer sets the time
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Radio Wide SMARTNET/SmartZone Screen

it performs this scan before it checks the expected 
frequencies again. After it checks these frequencies, it 
returns to full spectrum scanning. This cycle repeats 
until a control channel is found.

On-Off - Enables or disables full spectrum scan.

Timer - Sets the time that full spectrum scanning 
occurs as just described.

Hot DTMF

Enable/Disable - When enabled, allows the user to 
send DTMF tones while transmitting. When 
disabled, pressing numeric keys (0-9, , #) while 
transmitting has no affect. 

Display Options

These functions select what is displayed when 
group calls are received (see Section 2.5.3). If neither 
function is selected, the selected talk group alias is 
always displayed. Both cannot be selected. 

Talk Group on Rx - The alias of the talk group on 
which the call is being received is displayed.

PTT ID - The ID of the mobile placing the call is 
displayed. If the ID matches an ID in the Trunking 
Call List, the alias of that ID is displayed instead.

Scan Talkback 

When a message is received when scanning, this 
parameter selects how the radio responds during the 
call hang time. “Selected Group” forces it to transmit 
on the selected talk group, and “Active Group” forces 
it to transmit on the scanned or active talk group. 

Voice On Control

With SmartZone operation, some remote sites are 
designated Voice On Control sites. In these sites, if all 
available traffic channels are occupied, control chan-
nels become traffic channels when additional traffic 
channels are requested. The Voice On Control parame-
ters determine how the radio reacts to various situa-
tions that may occur. For example, when a conversa-
tion is complete, the radio may look for a control 
channel that has become a traffic channel.

Enable/Disable - Determines if the voice on control 
parameters are active.

Site Lock Time - This is the amount of time a radio 
remains on the Voice On Control site before looking 
for another site.

Activation Time - This is the amount of time the 
radio waits when the control channel comes back 
from Voice On Control before it transmits any 
pending ISWs. This prevents all radios on a Voice 
On Control site from submitting ISWs at the same 
time.

Pending Emergency Time - This is the amount of 
time the radio waits to submit an Emergency ISW 
after the control channel returns from the Voice On 
Control mode.

Adjustable Parameters

Busy Override Delay - With SmartZone operation, 
this is the amount of time a user must press the PTT 
switch to override a SmartZone busy that occurs 
because some member of the talk group is present at 
a site where there are no traffic channels available.

Affiliate Hold Off - With SmartZone operation, this 
is the delay time that occurs after acquiring the 
control channel before it sends an affiliation ISW. 

*
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This prevents all radios on the system from sending 
affiliation ISWs at the same time.

Failsoft Inactivity - Programs failsoft operation (see 
Section 2.5.11). If the radio remains inactive (no 
receive or transmit activity on channel) while oper-
ating in the failsoft mode for the programmed time, 
the radio momentarily leaves the failsoft mode and 
attempts to find a control channel. If “0” is 
programmed, the radio does not leave the failsoft 
mode.

3.4.5 RADIO-WIDE MOBILE OPTIONS SCREEN

The radio-wide Mobile Options screen is used to 
program the following parameters:

Backlight Level - Selects the default backlight level 
whenever power is on. This setting can be over-
ridden by the backlight option switch if it is 
programmed.

Hang-Up Box Monitor - Selecting “Off” disables 
microphone off-hook detection. Taking the micro-
phone off-hook then does not disable coded squelch 
functions or scanning. Selecting “On” enables 
microphone off-hook detection.

Ignition Power Down Time - When the ignition 
switch controls transceiver power, this sets the delay 
that occurs between when the ignition switch is 
turned off and when transceiver power actually 
turns off. Times of 0-254 minutes can be 
programmed or an infinite time (no turn-off) can be 
selected (Section 2.3.9).

Minimum Volume - Sets the minimum volume level 
that can be selected by the volume control. This can 
be used to prevent missed messages caused by inad-
vertently turning the volume down too far. Relative 
levels of 0-255 can be set (“0” sets the lowest 
minimum volume). 

3.5 PROGRAMMING CONVENTIONAL 
SYSTEMS AND CHANNELS

3.5.1 INTRODUCTION

The following information describes how 
conventional channels are programmed. Conventional 
systems do not need to be set up because only one can 
be programmed, and it is automatically set up when 
the programming file is selected as described in 
Section 3.1.6. Up to 256 conventional channels can be 
programmed (if no SMARTNET/SmartZone systems 
are programmed). Refer to Section 1.5.3 for more 
information on systems and channels.

The following is the recommended procedure for 
programming conventional channels:

1. Program the radio-wide information as described in 
Section 3.4. 

2. If other types of systems are programmed, make 
sure the conventional system is selected in the left 
pane or by selecting Window > Conventional in the 
menu bar (see Section 3.1.9).

3. Program the conventional system information and 
then the channel information as follows. 

3.5.2 CONVENTIONAL SYSTEM GENERAL 
SCREEN

The conventional system General screen is shown 
on the next page, and it programs the following 
parameters:

Timers

Tx Time-Out Timer - This timer limits the length of 
transmissions (Section 2.3.7). Times up to 3 
minutes, 45 seconds in 15-second steps can be 
programmed.
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Penalty Timer - This timer disables transmitting 
after the time-out timer expires (Section 2.4.7). 
Times up to 3 minutes, 45 seconds in 15-second 
steps can be programmed.

Conversation Timer - This timer limits the total 
length of a conversation (Section 2.4.8). Times up to 
7.5 minutes in 0.5-minute steps can be programmed.

Conventional System General Screen

Busy Channel Override - Selects if the busy channel 
lockout feature can be overridden by quickly releasing 
and then pressing the PTT switch (see Section 2.4.5).

Conventional System Scan List Screen

 Scan List Button

Clicking Scan List in the left pane or that button 
in the General screen displays the preceding screen 
which is used to program the conventional scan lists 
described in Section 2.4.11. 

NOTE: The conventional scan lists cannot be 
programmed until all the conventional channels are 
programmed. Therefore, first program the channels as 
described in Sections 3.5.3 and 3.5.4.

To modify a list, click  and the 
screen which follows is displayed. Select the desired 
scan list in the box on the top and then select the zone 
and the channels from that zone to be included. Repeat 
for each zone. Do this for each list programmed. The 

 button deletes the selected channel(s) 
from the scan list.

Conventional System Modify Scan List Screen

The following parameters are programmed in the 
Conventional System Scan List Screen shown on the 
left.

Keypad Editing

This function selects if the user is allowed to edit 
the scan list. This requires the Scan Edit option switch 
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as described in Section 2.3.11. User editing can be 
enabled and disabled on each scan list. 

Scan Mode

Sets the channel on which transmissions occur 
when the PTT switch is pressed while scanning. A 
different mode can be programmed for each scan list. 
In addition, it selects if priority sampling is used and 
also the type of priority channel (see the “Priority 
Channel” description which follows). The following 
modes are available:

No Priority - Priority sampling does not occur (all 
channels are scanned in sequence). The radio trans-
mits on the selected channel.

Priority/Tx Priority - Priority sampling occurs 
and the priority channel is the one programmed in 
the selected scan list. The radio transmits on the 
priority channel.

Priority/Tx Selected - Priority sampling occurs 
and the priority channel is the one programmed in 
the selected scan list. The radio transmits on the 
selected channel.

Priority on Sel Chan - The priority channel is 
always the selected channel (even if the scan list is 
programmed with a priority channel). The radio 
transmits on the selected channel. 

Talkback Scan - No priority sampling occurs 
(even if the scan list is programmed with a priority 
channel). The radio transmits on the channel of a 
call while scanning is halted. Then when scanning 
resumes, it transmits on the selected channel.

Scan Timers

Scan Hold Time - Sets the delay that occurs before 
scanning resumes after a signal is no longer 
received (see Section 2.3.11).

Lookback Time A - This time determines how 
often the priority channel is checked for activity. 
Times of 0.25-4.00 seconds in 0.25-second steps 
can be programmed.

Lookback Time B - This time determines how 
often the priority channel is checked once an incor-

rect Call Guard (CTCSS/DCS) code is detected. 
Since it takes much longer to detect an incorrect 
Call Guard signal than a carrier, this time should be 
relatively long to prevent the interruptions from 
making a message difficult to understand. Times of 
0.5-8.0 seconds can be programmed in 0.5-second 
steps.

Priority Channel Selection

The Scan Mode parameter in the preceding 
Conventional System Scan List screen selects if 
priority channel sampling is enabled on the selected 
scan list. It also selects the type of priority channel 
(either fixed or the selected) if applicable. 

If the “Priority/Tx Priority” or “Priority/Selected” 
mode is programmed, fixed priority channel sampling 
is selected. The fixed priority channel must then be 
chosen for the scan list. To do this, click the 

 button in the preceding Modify Scan List 
screen and then select the desired zone/channel. Refer 
to Section 2.4.12 for more information on priority 
channel sampling.

3.5.3 SETTING UP CONVENTIONAL 
CHANNELS 

The conventional Channel screen shown in 
Figure 3-3 which follows is displayed when a conven-
tional channel is selected. This screen programs 
unique channel parameters and also assigns channels 
to the selectable zones displayed by the transceiver.

The general procedure for setting up a conven-
tional channel is as follows. Refer to the descriptions 
which follow this procedure for information on the 
parameters in the channel screens.

1. Make sure that the desired zone is selected in the 
Zone box. 

2. Select the channel number in the Channels Index 
box which is to be programmed with the channel. If 
the channel number display mode is selected (see 
Section 2.4.2), this will be the number displayed 
when the channel is selected.

3. To assign a conventional channel, select “Conven-
tional” as the channel type. 
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Figure 3-3   Conventional Channel Screen
4. Click the Modify button to display the screen which 
enables that channel and programs the alias (tag) 
and transmit and receive frequencies. Then program 
the other parameters in the main part of the screen. 
Refer to the next section for more information.

3.5.4 CONVENTIONAL CHANNEL SCREEN 
PARAMETERS

The following parameters are programmed in the 
conventional channel screen shown in Figure 3-3.

Selected Channel

Zone Box - Clicking the arrow to the right of this 
box displays the available zones. Click on a zone to 
select it. Zones and zone aliases are set up on the 
Radio-Wide General screen described in Section 
3.4.2.

Channel Index Box - Displays the available chan-
nels in the selected zone. The channel type is 
selected by the Channel Type box below it.

 Modify Button - Displays the small 
screen shown in Figure 3-3 which enables the 

channel (makes it selectable) and programs the alias 
(tag) and transmit and receive frequencies.

The parameters in this screen are as follows:

Channel - Selects the channel to be edited.
Alias - Programs the identification that is displayed 

when the channel is selected. Up to 8 
characters can be programmed. 

Transmit - Programs the transmit frequency of the 
channel. 

Receive - Programs the receive frequency of the 
channel.

Enable This Channel - The box must be checked for 
the channel to be selectable. 

Rx Only - The box is checked if the channel is 
receive-only (transmitter disabled). 

Copy Parameters From Channel - If another channel 
is selected, the parameters from that 
channel are copied to the new channel.

NOTE: Channel numbers not assigned must be 
programmed for conventional operation and then not 
enabled in the Modify screen because SMARTNET/
SmartZone channels cannot be disabled.
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Channel Type

Channel Type Box - Selects the specific system 
from which the channel is selected. All programmed 
systems are displayed by number and type (conven-
tional, SMARTNET, SmartZone). When a different 
channel type is selected, the screen for that type of 
channel is automatically displayed. 

System Specific Information - With conventional 
systems, indicates the frequency of the selected 
channel without having to select the Modify box.

Transmit Power

This fixes the transmit power on the channel for 
the high or low level or allows it to be switch select-
able (the Hi/Lo Power option switch is then required). 
Refer to Section 2.4.10 for more information.

Tx Time-Out

This enables or disables the time-out timer on the 
channel. The time-out timer time is programmed in the 
conventional system General screen (Section 3.5.2).

Busy Channel Lockout

Off = disabled, Noise = transmit disallowed if 
carrier is detected, Tone = transmit allowed with 
carrier detected only if correct Call Guard (CTCSS/
DCS) code is detected.

Coded Squelch

This sets the transmit and receive Call Guard 
(CTCSS/DCS) coding, if any, used on the channel. If 
“None” is selected, no code is transmitted and carrier- 
controlled squelch is used when receiving (Section 
2.4.6). The standard Call Guard tones and codes are 
listed in Table 3-1 on page 3-23. 

Signaling

Off - No ANI signaling is used.

Leading ANI - A DTMF-coded ID is sent at the 
beginning of each transmission. This ID is set in the 
radio-wide conventional screen (Section 3.4.3).

Trailing ANI - A DTMF-coded ID is sent at the end 
of each transmission.

Channel Modulation

This selects if the channel modulation is wide-
band (5 kHz) or narrowband (2.5 kHz).

3.6 PROGRAMMING SMARTNET/SMARTZONE 
SYSTEMS AND CHANNELS

3.6.1 INTRODUCTION

To program SMARTNET and SmartZone 
systems and channels, proceed as follows: 

1. Program the SMARTNET/SmartZone radio-wide 
information as described in Section 3.4. 

2. To create a new SMARTNET/SmartZone system, 
select the Systems > Add Systems in the menu bar 
(see Section 3.1.11). Up to sixteen systems of any 
type can be programmed as described in Section 
1.5.3.

3. Program the SMARTNET/SmartZone system infor-
mation as described starting in the next section. 
Make sure the desired SMARTNET or SmartZone 
system is displayed by clicking it in the left pane or 
selecting it in the Window menu in the menu bar 
(see Section 3.1.9). Then program the channels as 
described starting in Section 3.6.8. 

3.6.2 SMARTNET/SMARTZONE SYSTEM 
GENERAL SCREEN

The SMARTNET/SmartZone System General 
screen is shown on the next page, and it programs the 
following parameters:

Restricted Access

Change System ID - Clicking Change System ID in 
the left pane or that button in the General screen 
displays the Change System ID screen which is used 
to enter the system ID of the system. This ID is 
entered as a hexadecimal number from 0-9 and A-F. 
Valid numbers are from 0001-FFFF. The system ID 
corresponding to the desired ID must also be located 
in the “key” subdirectory of the program file.
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System ID - Read-only field which shows the ID of 
the system currently being edited.

SMARTNET/SmartZone System General 
Screen

Splinter Channels

When splinter channels are enabled, the receive 
and transmit frequencies are 12.5 kHz lower than the 
normal frequencies. Splinter channels are used only as 
required in the Mexico and Canada border areas for 
frequencies between 806 and 820.975 MHz.

Channel Modulation

When “Wideband” is enabled, the radio operates 
with a 4 kHz maximum deviation between 821.000 
and 824.975 MHz and 5 kHz maximum deviation for 
all other frequencies. When it is disabled, deviation is 
5 kHz with all frequencies.

PTT ID

This enables or disables the PTT ID.

Transmission Trunking

Selecting “Disabled” removes the hang time at 
the end of a normal conversation. This forces the radio 
to always contact the control channel when seeking a 
channel grant instead of being able to key up on the 
hang time of another conversation.

System Lists

Clicking System Lists in the left pane or that 
button in the General screen displays the screens used 
to program the various lists that are unique for each 
SMARTNET/SmartZone system. Refer to Section 
3.6.7 for more information on these lists.

Dynamic Regrouping

Enable For This System - When this box is checked, 
a dynamic regrouping channel is enabled. This is a 
SMARTNET channel which has the corresponding 
talk group dynamically set by the dispatcher.

Zone - The physical zone containing the dynamic 
regrouping channel. The value is selected on the 
Channel Parameters screen.

Channel - The physical channel used for dynamic 
regrouping. The value is selected on the Channel 
Parameters screen.

Affiliation Type

Automatic - The radio immediately affiliates with 
the central controller as soon as it is turned on and 
automatically re-affiliates each time the talk group 
is changed.

On PTT - The radio affiliates with the central 
controller only when the PTT switch is pressed.

Time-Out Timer

This programs the time-out timer setting for the 
system. It can be programmed for 0 min, 15 sec up to 
3 min, 45 sec or it can be disabled (see Section 2.3.7).

ISW Delay Time

Increasing or decreasing this value changes the 
transmission timing of ISWs relative to the reception 
of OSWs.

3.6.3 SMARTNET/SMARTZONE SYSTEM 
OTHER ID’S SCREEN

The SMARTNET/SmartZone Other ID’s screen 
follows, and it programs the these parameters.
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SMARTNET/SmartZone Other IDs Screen

Individual ID - Uniquely identifies the radio on a 
particular system. Each radio must have a different 
Unit ID. Valid Unit IDs are from 1-65535.

Connect Tone - The tone expected by the controller 
on the traffic channel to verify that a subscriber 
transmission is occurring. This tone should be set 
the same as it is in the controller.

3.6.4 SMARTNET/SMARTZONE SYSTEM 
PHONE INTERCONNECT SCREEN

The SMARTNET/SmartZone Phone Intercon-
nect screen is shown above, and the parameters it 
programs are as follows: 

Phone Interconnect

Refer to Section 2.5.6 for more information on 
telephone calls.

Disabled - Telephone calls cannot be placed or 
received.

Answer Only - Telephone calls can be received but 
not placed.

List Only - Telephone calls can be placed and 
received, and numbers can be recalled from memory 
only.

Unlimited - Telephone calls can be placed and 
received, and numbers can be recalled from memory 
or dialed using a microphone keypad.

Private Call

This is the same as the preceding Phone Intercon-
nect except it is for private (unit-to-unit) calls. Refer to 
Sections 2.5.4 and 2.5.5 for more information.

Private Call II

This programs either standard (Private Conversa-
tion II™) or enhanced (Enhanced Private Conversa-
tion™) private calls as follows:

Standard - The user does not receive any feedback 
when the called radio is not active in the system. 
Only a “No Answer” is received if the called radio 
does not answer.

Enhanced - When a call is placed, the system tells 
the user if the called radio is currently active in the 
system and within range. The calling radio displays 
“NO ACK” if the called radio is not active in the 
system and “NO ANSWR” if it is active but does 
not answer.

Phone DTMF Timing

Initial Delay - Delay from 50-500 milliseconds from 
when a traffic channel is granted for phone intercon-
nect to the start of the dialing out of the phone 
number.

Digit Duration - Duration from 50-500 milliseconds 
of each phone number digit.

Inter-Digit Delay - Delay from 50-500 milliseconds 
between each digit of a phone number.

3.6.5 SMARTNET/SMARTZONE SYSTEM 
TALK GROUPS SCREEN

The SMARTNET/SmartZone Talk Groups screen 
is used to set up SMARTNET/SmartZone talk groups
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SMARTNET/SmartZone System Talk Groups 
Screen

and program unique talk group information. This 
screen is shown on the next page, and the parameters it 
programs are as follows: 

Talk Group - Selects the talk group to program. This 
is the actual ID of the talk group. Talk groups are 
added or deleted by clicking the Add TG or Delete 
TG button (see following). Talk groups are assigned 
to channels on the channel screen (see Section 
3.6.9).

 - Clicking this button displays a dialog 
box that adds a new talk group. The alias (alphatag) 
of up to 8 characters is entered, and the new group 
is then added after the others that are already set up. 
Each SMARTNET/SmartZone system can be 
programmed with up to 256 talk groups.

 - Clicking this button deletes the 
currently selected talk group (the one displayed in 
the “Talk Group” box).

Failsoft Channel

Enable - Enables a failsoft channel on the talk group 
if a controller failure occurs (see Section 2.5.11).

Disable - The failsoft mode is not entered if the
controller fails.

Tx/Rx Frequency - Programs the failsoft channel 
frequency if “Enabled” is checked.

3.6.6 SMARTNET/SMARTZONE SYSTEM 
EMERGENCY SETTINGS SCREEN

The SMARTNET/SmartZone Emergency 
Settings screen and the parameters it programs are as 
follows: 

Emergency Call

Enable - When the Emergency option switch and 
then the PTT switch are pressed, an emergency 
group call is transmitted.

Disable - An emergency group call is not 
authorized.

Emergency Hot Mic

Enable - When an emergency alarm is generated and 
the emergency alarm acknowledgment received, the 
emergency mode is automatically entered and trans-
mitting begins for the time specified by the Tx Period 
parameter (see following).

Disable - Automatic transmissions do not occur.

Tx Period - Defines the period during which trans-
missions occur with the microphone audio unmuted 
(without user intervention). Times of 10-120 seconds 
in 10-second steps can be selected.

Emergency Alarm

Disabled - No emergency signal is sent when the 
user presses the Emergency option switch.
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Normal - When the user presses the Emergency 
option switch, an emergency signal is sent to the 
dispatcher. Audio and visual feedback is provided 
by the radio.

Silent - Same as “Normal” except no audio or visual 
feedback is provided.

Retry Counter - When “Unlimited” is selected, an 
emergency call is repeated until acknowledged or 
canceled. When “Limited” is checked, calls are 
attempted only the specified number of times.

3.6.7 SMARTNET/SMARTZONE SYSTEM LISTS 
SCREENS

Clicking System Lists in the left pane or the 
 button in the SMARTNET General screen 

(if applicable) displays the screens used to program the 
various lists that are unique for each SMARTNET/
SmartZone system. These screens are as follows:

Trunking Phone List Screen

This screen programs the phone number list if 
used (see Section 2.5.6). To edit this list, click the 
Trunking Phone List tab and then the “Modify List” 
button on the right side of the screen. The following 
information is then programmed in the dialog box that 
is displayed:

Entry Number - This box selects the entry to be 
edited. The scroll bars to the right of this box select 
the desired entry. A phone list can contain up to 16 
entries. Selecting a new entry number automatically 
validates and stores the current entry. If the current 
entry contains an invalid field (for example, too 
many digits in the phone number), the entry number 
does not change and the invalid field is highlighted.

Entry Alias - Up to 8 characters can be entered to 
identify the phone number. This identification is 
displayed when phone numbers are selected by the 
user from the list. Only uppercase letters can be 
entered, so lowercase letters are automatically 
converted to uppercase by the program.

Phone Number - This is the number dialed when the 
location is selected. Characters that can be entered 
include 0-9, #, (,), and P (a “P” programs a pause). 
The maximum number of digits excluding (,) and 
spaces is 16, and the maximum including (,) and 
spaces is 24.

Close - Clicking this button verifies the current 
entry, stores it, and then closes the dialog box. If the 
current entry contains an invalid field, the dialog 
box does not close and the invalid field is high-
lighted.

Help - Accesses the Help screen. Help can also be 
selected at any time by pressing the F1 key.

Message Aliasing Screen

This screen associates an alias (name) with each 
message number (see Section 2.5.8). To edit this list, 
click the Message Aliasing tab and then the “Modify 
List” button on the right side. The following informa-
tion is then programmed in the dialog box that is 
displayed:

Message Number - This box selects the message to 
be edited. The scroll bars to the right of this box 
select the desired message number. 

Message Alias - Programs the alias which can be up 
to any 8 alphanumeric characters.
3-18
Revised January 2001
Part No. 001-7780-501



PROGRAMMING
Close Button - Validates the entry and closes the 
dialog box. The entry is also validated when another 
message number is selected.

Announcement Groups Screen

This screen programs the announcement groups 
that are used to communicate with several talk groups 
simultaneously. There can be up to 3 announcement 
groups per system, and each announcement group can 
have up to 15 talk groups. 

To create an announcement group, click the “Add 
AG” button and the “Add TGs to the AG” screen 
shown above is displayed. Enter the announcement 
group ID, click the talk groups to select/de-select those 
that are to be included, and then create the announce-
ment group by clicking the “Create AG” button. To 
delete the current announcement group, click the 
“Delete AG” button.

To edit an announcement group, click the 
“Modify List” button on the right and the preceding 
screen is displayed. Select the announcement group to 
be edited from a pull-down menu selecting by clicking 
the “AG” arrow. Then click the talk groups to select/
de-select them and then click the “Update List” button 
to make the changes. 

Control Channels Screen

This screen allows the system manager to view 
and edit the control channels. Each SMARTNET 
system can have up to four control channels, and each 
SmartZone system can have up to 32 control channels. 
Only one control channel is active at a time. 

To edit this list, click the Control Channels tab 
and then the “Modify List” button on the right side. 
The following information is then programmed in the 
dialog box that is displayed:

Control Channel - Selects the control channel to be 
edited. To add a new channel, click the “New Entry” 
button.

Frequency - The transmit and receive frequency of 
the control channel. These are the mobile frequen-
cies, not the repeater frequencies. Only multiples of 
5 kHz and 6.25 kHz are valid. With 800 MHz 
frequencies, a receive frequency 45 MHz above the 
transmit frequency is automatically entered.

New Entry Button - Click this button to display the 
dialog box used to add another control channel.
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Trunking Call List Screen

This screen allows the list of IDs used for private 
calls to be programmed. A maximum of 16 IDs can be 
programmed (see Sections 2.5.4 and 2.5.5). 

To edit this list, click the Trunking Call List tab 
and then the “Modify List” button on the right side. 
This following information is then programmed in the 
dialog box that is displayed:

Entry Number - This box selects the entry to be 
edited. The scroll bars to the right of this box select 
the desired entry. A private call list can contain up to 
16 entries. Selecting a new entry number automati-
cally validates and stores the current entry. If the 
current entry contains an invalid field, the entry 
number does not change and the invalid field is 
highlighted.

Entry Alias - Up to 8 characters can be entered to 
identify the user being called. This identification is 
displayed when the mobile to be called is selected 
by the user from the list. Only uppercase letters can 
be entered, so lowercase letters are automatically 
converted to uppercase by the program.

Call ID - This is the ID of the radio being called. 
Valid entries are 1-65535. A “0” is detected as no 
entry. 

Close Button - Verifies the current entry, stores it, 
and then closes the dialog box. If the current entry 
contains an invalid field, the dialog box does not 
close and the invalid field is highlighted.

Priority Monitor Scan Screen

This screen programs up to three Priority Monitor 
scan lists that are allowed. Each scan list can contain 
up to 15 channels plus a priority channel (see Section 
2.5.12). These channels must be from the same 
SMARTNET/SmartZone system. Channels set up for 
other systems are not allowed. 

To edit a list, click the Priority Monitor Scan tab 
and then click the “Modify List” button on the right 
side. A screen similar to the bottom screen shown 
above is then displayed to select the channels to be 
included in that scan list. Select channels as follows:

1. Select the scan list to be edited by clicking the scroll 
bars next to the “Scan List To Modify” box.

2. Select the first zone with channels to be included 
and select the desired channels. Repeat for the other 
zones.

3. To select the priority channel, click the Set Priority 
button. Then select the desired Zone/Channel or 
“None” if no priority channel is to be scanned.
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Figure 3-4   SMARTNET/SmartZone Channel Screen
4. Repeat the preceding steps for the other scan lists if 
applicable.

Status Aliasing Screen

This screen is shown above, and it programs the 
alias for each of up to eight status conditions that can 
be sent. The meaning of each status number is defined 
by the system manager. Refer to Section 2.5.9 for 
more information. 

To edit this list, click the Status Aliasing tab and 
then the “Modify List” button on the right side. The 
following information is then programmed in the 
dialog box that is displayed:

Status Number - The scroll bars to the right of this 
box select the status number that is to be edited. 

Status Alias - Programs up to 8 characters that iden-
tify the status. This identification is displayed when 
the user selects a status condition.
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3.6.8 SETTING UP SMARTNET/SMARTZONE 
CHANNELS 

The SMARTNET/SmartZone Channel screen 
shown in Figure 3-4 is displayed when the 
SMARTNET or SmartZone channel type is selected. 
This screen programs unique channel parameters and 
also assigns channels to the selectable zones displayed 
by the transceiver.

The general procedure for setting up a 
SMARTNET/SmartZone channel is as follows. Refer 
to the descriptions which follow this procedure for 
information on SMARTNET/SmartZone Channel 
screen parameters.

1. Make sure that the desired zone is selected in the 
Zone box. 

2. Select the channel number in the Channels Index 
box which is to be programmed with the channel.

3. To set up a SMARTNET channel, select 
“SMARTNET” as the channel type, and to set up a 
SmartZone channel, select “SmartZone”.

4. Click the Modify button to display the dialog box 
shown in the lower part of Figure 3-4. This box 
programs the alias (tag) that is displayed when it is 
selected.

5. Program the other parameters in the main part of the 
screen (see information which follows). 

3.6.9 SMARTNET/SMARTZONE CHANNEL 
SCREEN PARAMETERS

The following parameters are programmed in the 
SMARTNET/SmartZone channel screen shown in 
Figure 3-4.

Selected Channel

Zone Box - Clicking the arrow to the right of this 
box displays the available zones. Click on a zone to 
select it. Zones and zone aliases are set up on the 
Radio-Wide General screen described in Section 
3.4.2.

Channel Index Box - Displays the channels in the 
selected zone. The channel type is selected by the 
Channel Type box below it.

 - Displays the screen shown in the 
lower part of Figure 3-4. The parameters 
programmed in this screen are as follows:

Channel - Selects the channel to be edited.
Alias - Programs the identification that is displayed 

when the channel is selected. Up to 8 
characters can be programmed. 

Transmit - Not programmable because the transmit 
frequency is dynamically assigned over the 
air (“Trunked” is always displayed).

Receive - Dynamically assigned like the transmit 
frequency.

Enable This Channel - Not used because SMART-
NET/SmartZone channels are always 
enabled if set up. To disable a channel so 
that it is not selectable, choose the conven-
tional type and do not check this box.

Copy Parameters From Channel - If another channel 
is selected in the box, the parameters from 
that channel are copied to the new channel.

Channel Type

Channel Type Box - Selects the specific system 
from which the channel is selected. All programmed 
systems are displayed by number and type (conven-
tional, SMARTNET, SmartZone). When a different 
channel type is selected, the screen for that type of 
channel is automatically displayed. 

Other Screen Parameters

System Specific Information - With SMARTNET/
SmartZone systems, indicates the system ID 
programmed on the system General screen (see
Section 3.6.2).

Talk Group - Selects the talk group selected by that 
channel. Talk groups are programmed in the Talk 
Group screen described in Section 3.6.5.

Announcement Group - Selects one of up to three 
announcement groups selected by the channel. 
Refer to “Announcement Group Screen” in Section 
3.6.7 for more information.
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Emergency Group - Selects the talk group used for 
emergency calls.

Talk Permit Tone - When enabled, a short tone 
sounds after a request for a group call has been 
approved by the main controller. This indicates that 
speaking can begin. When disabled, no audio feed-
back is used to indicate when speaking can begin.

System Scan - Selects the Priority Monitor Scan list 
selected by the channel (see “Priority Monitor Scan 

Screen” description in Section 3.6.7). If “No Scan 
List” is programmed, scanning is not selectable on 
that channel.

Auto Scan - When enabled and a channel is selected, 
the radio automatically begins scanning the scan list 
associated with that channel. When disabled, scan-
ning can only be started manually by the Scan 
option switch.
Table 3-1   Call Guard (CTCSS/DCS) Codes and Tones

Recommended Tone Call Guard Codes

Code Freq Code Freq Code Freq Code Freq Code Freq
01 67.0 10 94.8 19 127.3 28 173.8 37* 241.8
02 71.9 11** 97.4 20 131.8 29 179.9 38* 250.3
03 74.4 12 100.0 21 136.5 30 186.2 39** 69.3
04 77.0 13 103.5 22 141.3 31 192.8 40** 206.5
05 79.7 14 107.2 23 146.2 32 203.5 41** 229.1
06 82.5 15 110.9 24 151.4 33 210.7 42** 254.1
07 85.4 16 114.8 25 156.7 34* 218.1
08 88.5 17 118.8 26 162.2 35* 225.7
09 91.5 18 123.0 27 167.9 36* 233.6
* These tones normally are not used because of their close proximity to the voice frequencies
** This tone is normally not used because it may cause interference with adjacent tones.

Recommended Digital Call Guard Codes
023 065 131 172 261 346 431 532 654 743
025 071 132 174 263 351 432 546 662 754
026 072 134 205 265 364 445 565 664
031 073 143 223 271 365 464 606 703
032 074 152 226 306 371 465 612 712
043 114 155 243 311 411 466 624 723
047 115 156 244 315 412 503 627 731
051 116 162 245 331 413 506 631 732
054 125 165 251 343 423 516 632 734
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1 851.0125 806.0125
2 851.0375 806.0375
3 851.0625 806.0625
4 851.0875 806.0875
5 851.1125 806.1125
6 851.1375 806.1375
7 851.1625 806.1625
8 851.1875 806.1875
9 851.2125 806.2125

10 851.2375 806.2375
11 851.2625 806.2625
12 851.2875 806.2875
13 851.3125 806.3125
14 851.3375 806.3375
15 851.3625 806.3625
16 851.3875 806.3875
17 851.4125 806.4125
18 851.4375 806.4375
19 851.4625 806.4625
20 851.4875 806.4875
21 851.5125 806.5125
22 851.5375 806.5375
23 851.5625 806.5625
24 851.5875 806.5875
25 851.6125 806.6125
26 851.6375 806.6375
27 851.6625 806.6625
28 851.6875 806.6875
29 851.7125 806.7125
30 851.7375 806.7375
31 851.7625 806.7625
32 851.7875 806.7875
33 851.8125 806.8125
34 851.8375 806.8375
35 851.8625 806.8625
36 851.8875 806.8875
37 851.9125 806.9125
38 851.9375 806.9375
39 851.9625 806.9625
40 851.9875 806.9875
41 852.0125 807.0125
42 852.0375 807.0375
43 852.0625 807.0625
44 852.0875 807.0875
45 852.1125 807.1125
46 852.1375 807.1375
47 852.1625 807.1625
48 852.1875 807.1875

49 852.2125 807.2125
50 852.2375 807.2375
51 852.2625 807.2625
52 852.2875 807.2875
53 852.3125 807.3125
54 852.3375 807.3375
55 852.3625 807.3625
56 852.3875 807.3875
57 852.4125 807.4125
58 852.4375 807.4375
59 852.4625 807.4625
60 852.4875 807.4875
61 852.5125 807.5125
62 852.5375 807.5375
63 852.5625 807.5625
64 852.5875 807.5875
65 852.6125 807.6125
66 852.6375 807.6375
67 852.6625 807.6625
68 852.6875 807.6875
69 852.7125 807.7125
70 852.7375 807.7375
71 852.7625 807.7625
72 852.7875 807.7875
73 852.8125 807.8125
74 852.8375 807.8375
75 852.8625 807.8625
76 852.8875 807.8875
77 852.9125 807.9125
78 852.9375 807.9375
79 852.9625 807.9625
80 852.9875 807.9875
81 853.0125 808.0125
82 853.0375 808.0375
83 853.0625 808.0625
84 853.0875 808.0875
85 853.1125 808.1125
86 853.1375 808.1375
87 853.1625 808.1625
88 853.1875 808.1875
89 853.2125 808.2125
90 853.2375 808.2375
91 853.2625 808.2625
92 853.2875 808.2875
93 853.3125 808.3125
94 853.3375 808.3375
95 853.3625 808.3625
96 853.3875 808.3875

97 853.4125 808.4125
98 853.4375 808.4375
99 853.4625 808.4625

100 853.4875 808.4875
101 853.5125 808.5125
102 853.5375 808.5375
103 853.5625 808.5625
104 853.5875 808.5875
105 853.6125 808.6125
106 853.6375 808.6375
107 853.6625 808.6625
108 853.6875 808.6875
109 853.7125 808.7125
110 853.7375 808.7375
111 853.7625 808.7625
112 853.7875 808.7875
113 853.8125 808.8125
114 853.8375 808.8375
115 853.8625 808.8625
116 853.8875 808.8875
117 853.9125 808.9125
118 853.9375 808.9375
119 853.9625 808.9625
120 853.9875 808.9875
121 854.0125 809.0125
122 854.0375 809.0375
123 854.0625 809.0625
124 854.0875 809.0875
125 854.1125 809.1125
126 854.1375 809.1375
127 854.1625 809.1625
128 854.1875 809.1875
129 854.2125 809.2125
130 854.2375 809.2375
131 854.2625 809.2625
132 854.2875 809.2875
133 854.3125 809.3125
134 854.3375 809.3375
135 854.3625 809.3625
136 854.3875 809.3875
137 854.4125 809.4125
138 854.4375 809.4375
139 854.4625 809.4625
140 854.4875 809.4875
141 854.5125 809.5125
142 854.5375 809.5375
143 854.5625 809.5625
144 854.5875 809.5875
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145 854.6125 809.6125
146 854.6375 809.6375
147 854.6625 809.6625
148 854.6875 809.6875
149 854.7125 809.7125
150 854.7375 809.7375
151 854.7625 809.7625
152 854.7875 809.7875
153 854.8125 809.8125
154 854.8375 809.8375
155 854.8625 809.8625
156 854.8875 809.8875
157 854.9125 809.9125
158 854.9375 809.9375
159 854.9625 809.9625
160 854.9875 809.9875
161 855.0125 810.0125
162 855.0375 810.0375
163 855.0625 810.0625
164 855.0875 810.0875
165 855.1125 810.1125
166 855.1375 810.1375
167 855.1625 810.1625
168 855.1875 810.1875
169 855.2125 810.2125
170 855.2375 810.2375
171 855.2625 810.2625
172 855.2875 810.2875
173 855.3125 810.3125
174 855.3375 810.3375
175 855.3625 810.3625
176 855.3875 810.3875
177 855.4125 810.4125
178 855.4375 810.4375
179 855.4625 810.4625
180 855.4875 810.4875
181 855.5125 810.5125
182 855.5375 810.5375
183 855.5625 810.5625
184 855.5875 810.5875
185 855.6125 810.6125
186 855.6375 810.6375
187 855.6625 810.6625
188 855.6875 810.6875
189 855.7125 810.7125
190 855.7375 810.7375
191 855.7625 810.7625
192 855.7875 810.7875

193 855.8125 810.8125
194 855.8375 810.8375
195 855.8625 810.8625
196 855.8875 810.8875
197 855.9125 810.9125
198 855.9375 810.9375
199 855.9625 810.9625
200 855.9875 810.9875
201 856.0125 811.0125
202 856.0375 811.0375
203 856.0625 811.0625
204 856.0875 811.0875
205 856.1125 811.1125
206 856.1375 811.1375
207 856.1625 811.1625
208 856.1875 811.1875
209 856.2125 811.2125
210 856.2375 811.2375
211 856.2625 811.2625
212 856.2875 811.2875
213 856.3125 811.3125
214 856.3375 811.3375
215 856.3625 811.3625
216 856.3875 811.3875
217 856.4125 811.4125
218 856.4375 811.4375
219 856.4625 811.4625
220 856.4875 811.4875
221 856.5125 811.5125
222 856.5375 811.5375
223 856.5625 811.5625
224 856.5875 811.5875
225 856.6125 811.6125
226 856.6375 811.6375
227 856.6625 811.6625
228 856.6875 811.6875
229 856.7125 811.7125
230 856.7375 811.7375
231 856.7625 811.7625
232 856.7875 811.7875
233 856.8125 811.8125
234 856.8375 811.8375
235 856.8625 811.8625
236 856.8875 811.8875
237 856.9125 811.9125
238 856.9375 811.9375
239 856.9625 811.9625
240 856.9875 811.9875

241 857.0125 812.0125
242 857.0375 812.0375
243 857.0625 812.0625
244 857.0875 812.0875
245 857.1125 812.1125
246 857.1375 812.1375
247 857.1625 812.1625
248 857.1875 812.1875
249 857.2125 812.2125
250 857.2375 812.2375
251 857.2625 812.2625
252 857.2875 812.2875
253 857.3125 812.3125
254 857.3375 812.3375
255 857.3625 812.3625
256 857.3875 812.3875
257 857.4125 812.4125
258 857.4375 812.4375
259 857.4625 812.4625
260 857.4875 812.4875
261 857.5125 812.5125
262 857.5375 812.5375
263 857.5625 812.5625
264 857.5875 812.5875
265 857.6125 812.6125
266 857.6375 812.6375
267 857.6625 812.6625
268 857.6875 812.6875
269 857.7125 812.7125
270 857.7375 812.7375
271 857.7625 812.7625
272 857.7875 812.7875
273 857.8125 812.8125
274 857.8375 812.8375
275 857.8625 812.8625
276 857.8875 812.8875
277 857.9125 812.9125
278 857.9375 812.9375
279 857.9625 812.9625
280 857.9875 812.9875
281 858.0125 813.0125
282 858.0375 813.0375
283 858.0625 813.0625
284 858.0875 813.0875
285 858.1125 813.1125
286 858.1375 813.1375
287 858.1625 813.1625
288 858.1875 813.1875
3-25
Revised January 2001
Part No. 001-7780-501



PROGRAMMING

FCC Chan. 
No. 

Mobile Rx 
Freq.

Mobile Tx 
Freq

FCC Chan. 
No. 

Mobile Rx 
Freq.

Mobile Tx 
Freq

FCC Chan. 
No. 

Mobile Rx 
Freq

Mobile Tx 
Freq

800 MHz Channels
289 858.2125 813.2125
290 858.2375 813.2375
291 858.2625 813.2625
292 858.2875 813.2875
293 858.3125 813.3125
294 858.3375 813.3375
295 858.3625 813.3625
296 858.3875 813.3875
297 858.4125 813.4125
298 858.4375 813.4375
299 858.4625 813.4625
300 858.4875 813.4875
301 858.5125 813.5125
302 858.5375 813.5375
303 858.5625 813.5625
304 858.5875 813.5875
305 858.6125 813.6125
306 858.6375 813.6375
307 858.6625 813.6625
308 858.6875 813.6875
309 858.7125 813.7125
310 858.7375 813.7375
311 858.7625 813.7625
312 858.7875 813.7875
313 858.8125 813.8125
314 858.8375 813.8375
315 858.8625 813.8625
316 858.8875 813.8875
317 858.9125 813.9125
318 858.9375 813.9375
319 858.9625 813.9625
320 858.9875 813.9875
321 859.0125 814.0125
322 859.0375 814.0375
323 859.0625 814.0625
324 859.0875 814.0875
325 859.1125 814.1125
326 859.1375 814.1375
327 859.1625 814.1625
328 859.1875 814.1875
329 859.2125 814.2125
330 859.2375 814.2375
331 859.2625 814.2625
332 859.2875 814.2875
333 859.3125 814.3125
334 859.3375 814.3375
335 859.3625 814.3625
336 859.3875 814.3875

337 859.4125 814.4125
338 859.4375 814.4375
339 859.4625 814.4625
340 859.4875 814.4875
341 859.5125 814.5125
342 859.5375 814.5375
343 859.5625 814.5625
344 859.5875 814.5875
345 859.6125 814.6125
346 859.6375 814.6375
347 859.6625 814.6625
348 859.6875 814.6875
349 859.7125 814.7125
350 859.7375 814.7375
351 859.7625 814.7625
352 859.7875 814.7875
353 859.8125 814.8125
354 859.8375 814.8375
355 859.8625 814.8625
356 859.8875 814.8875
357 859.9125 814.9125
358 859.9375 814.9375
359 859.9625 814.9625
360 859.9875 814.9875
361 860.0125 815.0125
362 860.0375 815.0375
363 860.0625 815.0625
364 860.0875 815.0875
365 860.1125 815.1125
366 860.1375 815.1375
367 860.1625 815.1625
368 860.1875 815.1875
369 860.2125 815.2125
370 860.2375 815.2375
371 860.2625 815.2625
372 860.2875 815.2875
373 860.3125 815.3125
374 860.3375 815.3375
375 860.3625 815.3625
376 860.3875 815.3875
377 860.4125 815.4125
378 860.4375 815.4375
379 860.4625 815.4625
380 860.4875 815.4875
381 860.5125 815.5125
382 860.5375 815.5375
383 860.5625 815.5625
384 860.5875 815.5875

385 860.6125 815.6125
386 860.6375 815.6375
387 860.6625 815.6625
388 860.6875 815.6875
389 860.7125 815.7125
390 860.7375 815.7375
391 860.7625 815.7625
392 860.7875 815.7875
393 860.8125 815.8125
394 860.8375 815.8375
395 860.8625 815.8625
396 860.8875 815.8875
397 860.9125 815.9125
398 860.9375 815.9375
399 860.9625 815.9625
400 860.9875 815.9875
401 861.0125 816.0125
402 861.0375 816.0375
403 861.0625 816.0625
404 861.0875 816.0875
405 861.1125 816.1125
406 861.1375 816.1375
407 861.1625 816.1625
408 861.1875 816.1875
409 861.2125 816.2125
410 861.2375 816.2375
411 861.2625 816.2625
412 861.2875 816.2875
413 861.3125 816.3125
414 861.3375 816.3375
415 861.3625 816.3625
416 861.3875 816.3875
417 861.4125 816.4125
418 861.4375 816.4375
419 861.4625 816.4625
420 861.4875 816.4875
421 861.5125 816.5125
422 861.5375 816.5375
423 861.5625 816.5625
424 861.5875 816.5875
425 861.6125 816.6125
426 861.6375 816.6375
427 861.6625 816.6625
428 861.6875 816.6875
429 861.7125 816.7125
430 861.7375 816.7375
431 861.7625 816.7625
432 861.7875 816.7875
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433 861.8125 816.8125
434 861.8375 816.8375
435 861.8625 816.8625
436 861.8875 816.8875
437 861.9125 816.9125
438 861.9375 816.9375
439 861.9625 816.9625
440 861.9875 816.9875
441 862.0125 817.0125
442 862.0375 817.0375
443 862.0625 817.0625
444 862.0875 817.0875
445 862.1125 817.1125
446 862.1375 817.1375
447 862.1625 817.1625
448 862.1875 817.1875
449 862.2125 817.2125
450 862.2375 817.2375
451 862.2625 817.2625
452 862.2875 817.2875
453 862.3125 817.3125
454 862.3375 817.3375
455 862.3625 817.3625
456 862.3875 817.3875
457 862.4125 817.4125
458 862.4375 817.4375
459 862.4625 817.4625
460 862.4875 817.4875
461 862.5125 817.5125
462 862.5375 817.5375
463 862.5625 817.5625
464 862.5875 817.5875
465 862.6125 817.6125
466 862.6375 817.6375
467 862.6625 817.6625
468 862.6875 817.6875
469 862.7125 817.7125
470 862.7375 817.7375
471 862.7625 817.7625
472 862.7875 817.7875
473 862.8125 817.8125
474 862.8375 817.8375
475 862.8625 817.8625
476 862.8875 817.8875
477 862.9125 817.9125
478 862.9375 817.9375
479 862.9625 817.9625
480 862.9875 817.9875

481 863.0125 818.0125
482 863.0375 818.0375
483 863.0625 818.0625
484 863.0875 818.0875
485 863.1125 818.1125
486 863.1375 818.1375
487 863.1625 818.1625
488 863.1875 818.1875
489 863.2125 818.2125
490 863.2375 818.2375
491 863.2625 818.2625
492 863.2875 818.2875
493 863.3125 818.3125
494 863.3375 818.3375
495 863.3625 818.3625
496 863.3875 818.3875
497 863.4125 818.4125
498 863.4375 818.4375
499 863.4625 818.4625
500 863.4875 818.4875
501 863.5125 818.5125
502 863.5375 818.5375
503 863.5625 818.5625
504 863.5875 818.5875
505 863.6125 818.6125
506 863.6375 818.6375
507 863.6625 818.6625
508 863.6875 818.6875
509 863.7125 818.7125
510 863.7375 818.7375
511 863.7625 818.7625
512 863.7875 818.7875
513 863.8125 818.8125
514 863.8375 818.8375
515 863.8625 818.8625
516 863.8875 818.8875
517 863.9125 818.9125
518 863.9375 818.9375
519 863.9625 818.9625
520 863.9875 818.9875
521 864.0125 819.0125
522 864.0375 819.0375
523 864.0625 819.0625
524 864.0875 819.0875
525 864.1125 819.1125
526 864.1375 819.1375
527 864.1625 819.1625
528 864.1875 819.1875

529 864.2125 819.2125
530 864.2375 819.2375
531 864.2625 819.2625
532 864.2875 819.2875
533 864.3125 819.3125
534 864.3375 819.3375
535 864.3625 819.3625
536 864.3875 819.3875
537 864.4125 819.4125
538 864.4375 819.4375
539 864.4625 819.4625
540 864.4875 819.4875
541 864.5125 819.5125
542 864.5375 819.5375
543 864.5625 819.5625
544 864.5875 819.5875
545 864.6125 819.6125
546 864.6375 819.6375
547 864.6625 819.6625
548 864.6875 819.6875
549 864.7125 819.7125
550 864.7375 819.7375
551 864.7625 819.7625
552 864.7875 819.7875
553 864.8125 819.8125
554 864.8375 819.8375
555 864.8625 819.8625
556 864.8875 819.8875
557 864.9125 819.9125
558 864.9375 819.9375
559 864.9625 819.9625
560 864.9875 819.9875
561 865.0125 820.0125
562 865.0375 820.0375
563 865.0625 820.0625
564 865.0875 820.0875
565 865.1125 820.1125
566 865.1375 820.1375
567 865.1625 820.1625
568 865.1875 820.1875
569 865.2125 820.2125
570 865.2375 820.2375
571 865.2625 820.2625
572 865.2875 820.2875
573 865.3125 820.3125
574 865.3375 820.3375
575 865.3625 820.3625
576 865.3875 820.3875
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577 865.4125 820.4125
578 865.4375 820.4375
579 865.4625 820.4625
580 865.4875 820.4875
581 865.5125 820.5125
582 865.5375 820.5375
583 865.5625 820.5625
584 865.5875 820.5875
585 865.6125 820.6125
586 865.6375 820.6375
587 865.6625 820.6625
588 865.6875 820.6875
589 865.7125 820.7125
590 865.7375 820.7375
591 865.7625 820.7625
592 865.7875 820.7875
593 865.8125 820.8125
594 865.8375 820.8375
595 865.8625 820.8625
596 865.8875 820.8875
597 865.9125 820.9125
598 865.9375 820.9375
599 865.9625 820.9625
600 865.9875 820.9875

- 866.0000 821.0000
601 866.0125 821.0125

- 866.0250 821.0250
602 866.0375 821.0375
603 866.0500 821.0500
604 866.0625 821.0625
605 866.0750 821.0750
606 866.0875 821.0875
607 866.1000 821.1000
608 866.1125 821.1125
609 866.1250 821.1250
610 866.1375 821.1375
611 866.1500 821.1500
612 866.1625 821.1625
613 866.1750 821.1750
614 866.1875 821.1875
615 866.2000 821.2000
616 866.2125 821.2125
617 866.2250 821.2250
618 866.2375 821.2375
619 866.2500 821.2500
620 866.2625 821.2625
621 866.2750 821.2750
622 866.2875 821.2875

623 866.3000 821.3000
624 866.3125 821.3125
625 866.3250 821.3250
626 866.3375 821.3375
627 866.3500 821.3500
628 866.3625 821.3625
629 866.3750 821.3750
630 866.3875 821.3875
631 866.4000 821.4000
632 866.4125 821.4125
633 866.4250 821.4250
634 866.4375 821.4375
635 866.4500 821.4500
636 866.4625 821.4625
637 866.4750 821.4750
638 866.4875 821.4875

- 866.5000 821.5000
639 866.5125 821.5125

- 866.5250 821.5250
640 866.5375 821.5375
641 866.5500 821.5500
642 866.5625 821.5625
643 866.5750 821.5750
644 866.5875 821.5875
645 866.6000 821.6000
646 866.6125 821.6125
647 866.6250 821.6250
648 866.6375 821.6375
649 866.6500 821.6500
650 866.6625 821.6625
651 866.6750 821.6750
652 866.6875 821.6875
653 866.7000 821.7000
654 866.7125 821.7125
655 866.7250 821.7250
656 866.7375 821.7375
657 866.7500 821.7500
658 866.7625 821.7625
659 866.7750 821.7750
660 866.7875 821.7875
661 866.8000 821.8000
662 866.8125 821.8125
663 866.8250 821.8250
664 866.8375 821.8375
665 866.8500 821.8500
666 866.8625 821.8625
667 866.8750 821.8750
668 866.8875 821.8875

669 866.9000 821.9000
670 866.9125 821.9125
671 866.9250 821.9250
672 866.9375 821.9375
673 866.9500 821.9500
674 866.9625 821.9625
675 866.9750 821.9750
676 866.9875 821.9875

- 867.0000 822.0000
677 867.0125 822.0125

- 867.0250 822.0250
678 867.0375 822.0375
679 867.0500 822.0500
680 867.0625 822.0625
681 867.0750 822.0750
682 867.0875 822.0875
683 867.1000 822.1000
684 867.1125 822.1125
685 867.1250 822.1250
686 867.1375 822.1375
687 867.1500 822.1500
688 867.1625 822.1625
689 867.1750 822.1750
690 867.1875 822.1875
691 867.2000 822.2000
692 867.2125 822.2125
693 867.2250 822.2250
694 867.2375 822.2375
695 867.2500 822.2500
696 867.2625 822.2625
697 867.2750 822.2750
698 867.2875 822.2875
699 867.3000 822.3000
700 867.3125 822.3125
701 867.3250 822.3250
702 867.3375 822.3375
703 867.3500 822.3500
704 867.3625 822.3625
705 867.3750 822.3750
706 867.3875 822.3875
707 867.4000 822.4000
708 867.4125 822.4125
709 867.4250 822.4250
710 867.4375 822.4375
711 867.4500 822.4500
712 867.4625 822.4625
713 867.4750 822.4750
714 867.4875 822.4875
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FCC Chan. 
No. 

Mobile Rx 
Freq.

Mobile Tx 
Freq

FCC Chan. 
No. 

Mobile Rx 
Freq.

Mobile Tx 
Freq

FCC Chan. 
No. 

Mobile Rx 
Freq

Mobile Tx 
Freq

800 MHz Channels
- 867.5000 822.5000
715 867.5125 822.5125

- 867.5250 822.5250
716 867.5375 822.5375
717 867.5500 822.5500
718 867.5625 822.5625
719 867.5750 822.5750
720 867.5875 822.5875
721 867.6000 822.6000
722 867.6125 822.6125
723 867.6250 822.6250
724 867.6375 822.6375
725 867.6500 822.6500
726 867.6625 822.6625
727 867.6750 822.6750
728 867.6875 822.6875
729 867.7000 822.7000
730 867.7125 822.7125
731 867.7250 822.7250
732 867.7375 822.7375
733 867.7500 822.7500
734 867.7625 822.7625
735 867.7750 822.7750
736 867.7875 822.7875
737 867.8000 822.8000
738 867.8125 822.8125
739 867.8250 822.8250
740 867.8375 822.8375
741 867.8500 822.8500
742 867.8625 822.8625
743 867.8750 822.8750
744 867.8875 822.8875
745 867.9000 822.9000
746 867.9125 822.9125
747 867.9250 822.9250
748 867.9375 822.9375
749 867.9500 822.9500
750 867.9625 822.9625
751 867.9750 822.9750
752 867.9875 822.9875

- 868.0000 823.0000
753 868.0125 823.0125

- 868.0250 823.0250
754 868.0375 823.0375
755 868.0500 823.0500
756 868.0625 823.0625
757 868.0750 823.0750
758 868.0875 823.0875

759 868.1000 823.1000
760 868.1125 823.1125
761 868.1250 823.1250
762 868.1375 823.1375
763 868.1500 823.1500
764 868.1625 823.1625
765 868.1750 823.1750
766 868.1875 823.1875
767 868.2000 823.2000
768 868.2125 823.2125
769 868.2250 823.2250
770 868.2375 823.2375
771 868.2500 823.2500
772 868.2625 823.2625
773 868.2750 823.2750
774 868.2875 823.2875
775 868.3000 823.3000
776 868.3125 823.3125
777 868.3250 823.3250
778 868.3375 823.3375
779 868.3500 823.3500
780 868.3625 823.3625
781 868.3750 823.3750
782 868.3875 823.3875
783 868.4000 823.4000
784 868.4125 823.4125
785 868.4250 823.4250
786 868.4375 823.4375
787 868.4500 823.4500
788 868.4625 823.4625
789 868.4750 823.4750
790 868.4875 823.4875
791 868.5000 823.5000
792 868.5125 823.5125
793 868.5250 823.5250
794 868.5375 823.5375
795 868.5500 823.5500
796 868.5625 823.5625
797 868.5750 823.5750
798 868.5875 823.5875
799 868.6000 823.6000
800 868.6125 823.6125
801 868.6250 823.6250
802 868.6375 823.6375
803 868.6500 823.6500
804 868.6625 823.6625
805 868.6750 823.6750
806 868.6875 823.6875

807 868.7000 823.7000
808 868.7125 823.7125
809 868.7250 823.7250
810 868.7375 823.7375
811 868.7500 823.7500
812 868.7625 823.7625
813 868.7750 823.7750
814 868.7875 823.7875
815 868.8000 823.8000
816 868.8125 823.8125
817 868.8250 823.8250
818 868.8375 823.8375
819 868.8500 823.8500
820 868.8625 823.8625
821 868.8750 823.8750
822 868.8875 823.8875
823 868.9000 823.9000
824 868.9125 823.9125
825 868.9250 823.9250
826 868.9375 823.9375
827 868.9500 823.9500
828 868.9625 823.9625
829 868.9750 823.9750
830 868.9875 823.9875

- 869.0000 824.0000
- 869.0125 824.0125
- 869.0250 824.0250
- 869.0375 824.0375
- 869.0500 824.0500
- 869.0625 824.0625
- 869.0750 824.0750
- 869.0875 824.0875
- 869.1000 824.1000
- 869.1125 824.1125
- 869.1250 824.1250
- 869.1375 824.1375
- 869.1500 824.1500
- 869.1625 824.1625
- 869.1750 824.1750
- 869.1875 824.1875
- 869.2000 824.2000
- 869.2125 824.2125
- 869.2250 824.2250
- 869.2375 824.2375
- 869.2500 824.2500
- 869.2625 824.2625
- 869.2750 824.2750
- 869.2875 824.2875
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FCC Chan. 
No. 

Mobile Rx 
Freq.

Mobile Tx 
Freq

FCC Chan. 
No. 

Mobile Rx 
Freq.

Mobile Tx 
Freq

FCC Chan. 
No. 

Mobile Rx 
Freq

Mobile Tx 
Freq

800 MHz Channels
- 869.3000 824.3000
- 869.3125 824.3125
- 869.3250 824.3250
- 869.3375 824.3375
- 869.3500 824.3500
- 869.3625 824.3625
- 869.3750 824.3750
- 869.3875 824.3875
- 869.4000 824.4000
- 869.4125 824.4125
- 869.4250 824.4250
- 869.4375 824.4375
- 869.4500 824.4500
- 869.4625 824.4625
- 869.4750 824.4750
- 869.4875 824.4875
- 869.5000 824.5000
- 869.5125 824.5125
- 869.5250 824.5250

- 869.5375 824.5375
- 869.5500 824.5500
- 869.5625 824.5625
- 869.5750 824.5750
- 869.5875 824.5875
- 869.6000 824.6000
- 869.6125 824.6125
- 869.6250 824.6250
- 869.6375 824.6375
- 869.6500 824.6500
- 869.6625 824.6625
- 869.6750 824.6750
- 869.6875 824.6875
- 869.7000 824.7000
- 869.7125 824.7125
- 869.7250 824.7250
- 869.7375 824.7375
- 869.7500 824.7500
- 869.7625 824.7625

- 869.7750 824.7750
- 869.7875 824.7875
- 869.8000 824.8000
- 869.8125 824.8125
- 869.8250 824.8250
- 869.8375 824.8375
- 869.8500 824.8500
- 869.8625 824.8625
- 869.8750 824.8750
- 869.8875 824.8875
- 869.9000 824.9000
- 869.9125 824.9125
- 869.9250 824.9250
- 869.9375 824.9375
- 869.9500 824.9500
- 869.9625 824.9625
- 869.9750 824.9750
- 869.9875 824.9875
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SECTION 4   ALIGNMENT AND PERFORMANCE TESTS
Figure 4-1   Alignment Setup

Ign Sense

Remote Programming Interface (RPI)

13.6 VDC
Power Supply

Signal Generator/

Wattmeter

50-ohm
Load

Comm. Monitor

(Optional)

Part No. 023-9800-000

PC-Compatible
Computer

4.7-ohm
Speaker Load
4.1 GENERAL

4.1.1 INTRODUCTION

The alignment procedure described in this section 
should be performed if repairs are made that could 
affect the factory alignment. In addition, before a 
transceiver is initially placed in service, the perfor-
mance tests described in Section 4.8 should be 
performed. 

To perform the alignment described in this 
section, special PCTune software (see Table 1-1) and 
the same basic computer setup used for programming 
is required. This equipment is shown above and also 
described in Section 3.1. Remote Programming Inter-
face (RPI), Part No. 023-9800-000, or others can be 
used (except 023-5300-000). The speaker and micro-
phone audio jacks on the 9800 RPI are not required in 
this application. 

With 800 MHz models, only three or four adjust-
ments are made manually and the others are made 
digitally using the PCTune software. The manual 
adjustments tune the IF and high power PA, and set the 
TCXO frequency. If they do not need to be reset, the 
transceiver can be tuned without removing the top or 
bottom covers.

This transceiver does not have a special test mode 
that is selected. The PCTune software automatically 
selects the frequencies and other test conditions that 
are required to perform the alignment. If the trans-
ceiver must be controlled manually to perform such 
things as testing or troubleshooting, program tempo-
rary conventional channels.

4.1.2 TEST SETUP

Connect the test setup shown in Figure 4-1. Addi-
tional information follows on equipment in this setup.
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ALIGNMENT AND PERFORMANCE TESTS
RF Signal Generator - When connecting the gener-
ator to the antenna jack, use at least a 6 dB pad 
between the generator and transceiver. This protects 
the generator if the transmitter is accidentally keyed 
and also ensures that a 50-ohm load exists. The input 
levels listed in the PCTune screens are at the antenna 
jack, so increase the generator output accordingly. 

Power Source - Typical current when transmitting is 7 
amperes with 15-watt models, and 11 amperes with 
30-watt models. Therefore, a power supply capable of 
producing that current at 13.6 volts is required.

Wattmeter/Load - The wattmeter and dummy load 
must measure and dissipate up to approximately 30 
watts. For accurate power output measurement at 800 
MHz, use a minimum number of connectors with a 
Teflon or better dielectric. If coaxial cable is used, it 
should be a minimum length of a low-loss type.

Speaker Load - The speaker load is connected to the 
1/8” phone jack on the back of the transceiver.

Computer and RPI - The RPI is connected to the 
computer and transceiver as described in Section 
3.1.4. RPI, Part No. 023-9800-000 or other RPIs 
(except 023-5300-000) can be used as described in the 
preceding section. 

4.1.3 TUNE SOFTWARE 

General

The PCTune software is a Windows®-based 
program. Minimum software and hardware require-
ments are as follows:

• Windows® 95 or 3.1
• 386SX or faster microprocessor
• 4 megabytes of RAM
• 3 megabytes free space available on hard drive
• An available serial port

Software Installation

Proceed as follows to install this software:

1. Close all applications that are currently running 
(other than Windows).

2. Insert the disk containing the PCTune software in 
drive A: (or B:).

3. From the Windows 95 taskbar, choose RUN and 
open SETUP.EXE on drive A: (or B:). Alternatively, 
use File Explorer and double click SETUP.EXE.

From the Windows 3.1 Program Manager, choose 
FILE > RUN and select the SETUP.EXE file on 
drive A: (or B:).

4. Follow the instructions on the screen. The program 
is automatically loaded on the hard drive and start-
up shortcuts or groups are created.

Starting PCTune

From Windows 95 - Select Start in the taskbar, then 
Programs > PCTune > PCTune.

From Windows 3.1 - From the Program Manager, 
open the PCTune group and then double click the 
PCTune icon. 

Exiting PCTune

Select File > Exit or click the “X” button on the 
right end of the title bar.

4.1.4 PRELIMINARY SETUP

1. With transceiver power turned off, connect the RPI 
to an unused serial port of the computer. Then 
connect the RPI to the microphone jack of the trans-
ceiver (see Section 3.1.4).

2. Start the PCTune program as described in the 
preceding section. If required, select the serial port 
being used by selecting Options > Set Comm Port.

3. Turn transceiver power on and the green indicator 
on the RPI should light. Move the selector switch on 
the RPI to the other position if this indicator is 
amber.

4. Follow the instructions on the screen to display the 
main screen shown in Figure 4-2. Select Tuning > 
Complete Tuning to automatically step through a 
complete alignment or Tuning > Partial Tuning to 
manually select each adjustment.
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Figure 4-2   PCTune Main Screen
5. The computer then attempts to establish communi-
cation with the transceiver. When communication is 
established, “Com Link Established” is displayed in 
the “Status” box and “TUNING” is indicated in the 
transceiver display. Instructions are then displayed 
in the “Instructions” box on how to proceed with 
each adjustment.

Figure 4-3   Tune Parameters Screen

4.1.5 READING CURRENT SETTINGS

To read and display the settings currently 
programmed in a transceiver, select Tuning > Display 
Tune Parameters from the Menu bar. The screen in 
Figure 4-3 is then displayed. The following functions 
can be performed from this screen:

• To read the settings in the transceiver from this 
screen, click the “Read” button.

• To write the settings in this screen to the transceiver, 
click the “Write” button.

• To set all parameters in this screen to a default level, 
click the “Set Defaults” button.

• To set only the RSSI levels to the default level, click 
the “Set RSSI Defaults Only” button.

4.2 TRANSMIT POWER OUTPUT

1. Connect a wattmeter and 50-ohm load to the 
antenna jack as shown in Figure 4-1. Manually or 
automatically select “Tx Power” and follow the on-
screen instructions.
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2. With high power (30W) models only, C656 on the 
PA board is adjusted for minimum current. Remove 
the bottom cover and adjust C656 as required. 

3. Adjust for the displayed power output at various 
frequencies across the band. A high and low power 
output level is set by this function. The allowable 
power output range for each model is as follows:

Mid Power (15W) Models - 2-15 watts
High Power (30W) Models - 10-30 watts

4.3 FREQUENCY SET/VCO CHECK

1. Connect a 50-ohm load to the antenna jack and 
monitor the transmit signal with a communication 
monitor.

2. Select the Frequency Set/VCO Check function. Set 
the communication monitor to the displayed 
frequency and click the “OK” button to key the 
transmitter and begin the adjustment process.

3. If adjustment is required, remove the top cover of 
the transceiver to access the RF board. Then manu-
ally adjust the variable capacitor in reference 
oscillator U806 for the displayed frequency ±100 
Hz (see Figure 4-4). This also sets the receive 
frequency.

4. The VCO control line voltage can be checked for the 
indicated readings at the junction of R848 and C836. 
If it is not within the indicated limits, there may be 
a synthesizer problem or the VCO may be defective. 
The control voltage is not adjustable.

4.4 TRANSMIT MODULATION

Transmit modulation is set by balancing the 
modulation produced by 80 Hz and 3 kHz tones and 
then setting modulation limiting using a 1 kHz tone. 
All of these tones are internally generated by the trans-
ceiver, so no external audio generator is required. 
Proceed as follows:

1. Connect a 50-ohm load to the antenna jack and 
monitor the transmit signal with a communication 
monitor. Manually or automatically select “Tx 
Modulation”.

2. Set the communication monitor for the displayed 
frequency and then click “OK” to transmit a signal 
modulated with an 80 Hz tone. Enter the measured 
deviation (in hertz) in the displayed box and click 
“OK”.

3. Continue following the screen instructions to adjust 
the 3 kHz tone deviation. The + and – buttons are 
clicked to set the deviation to the indicated level. 
The 1 kHz tone is then adjusted.

4. The preceding 3 kHz and 1 kHz tone adjustments 
are then repeated on several frequencies across the 
band. After the last adjustment is made, the trans-
mitter unkeys and the settings are stored.

Figure 4-4   Alignment Points Diagram

J201

L218

Ref Osc Freq.

L215 L213

Pin 20 Pin 19
R848/C836
4-4
Revised January 2001
Part No. 001-9800-501



ALIGNMENT AND PERFORMANCE TESTS
4.5 RECEIVER IF ALIGNMENT AND CHECK

1. If required, remove the top cover of the transceiver 
to access the RF board. Manually or automatically 
select “Receiver IF Alignment”. 

2. Connect an RF signal generator to the antenna jack 
using a 6 dB or greater pad. Set the generator output 
for the displayed frequency, modulated with 1 kHz 
at 3 kHz deviation. 

3. Connect the DC voltmeter to J201, pin 20 (see 
Figure 4-4). Set the generator output level for –47 
dBm (1.0 mV) at the antenna jack. and manually 
adjust L218 for a meter reading of 2.9 V ±0.1 V.

4. Set the generator output level for –80 dBm (22 µV) 
at the antenna jack. Connect a SINAD meter to the 
speaker jack on the back of the transceiver and 
adjust the volume level to approximately 1/3 of the 
maximum level. Click “OK” and manually adjust 
L213 and L215 for best SINAD.

5. Manually or automatically select “Receiver Check”. 
Follow the instructions to check SINAD sensitivity 
on the low, mid, and high channels indicated. Click 
the Wide Band/Narrow Band button to switch the 
selected bandwidth. Use 3 kHz deviation for wide 
band channels and 1.5 kHz deviation for narrow 
band channels.

4.6 SQUELCH ADJUSTMENT

1. Connect an RF signal generator to the antenna jack 
using a 6 dB or greater pad. Also connect a SINAD 
meter to the speaker jack and adjust the volume to 
1/3 maximum if required.

2. Manually or automatically select “Squelch”. Set the 
signal generator for the indicated frequency and 
modulation and adjust the output level for the indi-
cated SINAD level.

3. Follow the instructions on the screen to adjust the 
wide and narrow band squelch level.

4.7 RSSI ADJUSTMENT

This adjustment calibrates the RSSI signal level. 
Proceed as follows:

1. Manually or automatically select “RSSI”. Connect 
an RF signal generator to the antenna jack using a 6 
dB or greater pad and set it for the displayed 
frequency and output level. 

2. Follow the instructions displayed on the screen. 

4.8 PERFORMANCE TESTING

Performance testing can be accomplished by 
programming temporary conventional channels and 
then checking receiver and transmitter operation on 
those channels. Channels should be programmed at the 
low, mid, and high ends of the operating band.

The PCTune software described in the preceding 
information can also be used for basic performance 
testing. Transmitter power output can be checked as 
described in Section 4.2, and receiver sensitivity can 
be checked as described in Section 4.5. 

Receiver and transmitter specifications you may 
want to check are as follows: 

Receiver Specifications

12 dB SINAD Sensitivity - 0.35 µV maximum
Audio Power Output - 5 watts (w/external 4.7-ohm

load)
Audio Distortion - Less than 5%

Transmitter Specifications

RF Power Output:
15-Watt Models - 2-15 watts 
30-Watt Models - 10-30 watts

Wideband Deviation:
Voice Only - 3.0 kHz ±100 Hz
Data Only -1000 Hz ±100 Hz
Total Voice and Data - 4.7 kHz maximum

Narrow Band Deviation:
Voice Only - 1.2 kHz ±100 Hz
Data Only - 800 Hz ±100 Hz
Total Voice and Data - 2.3 kHz maximum
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SECTION 5   DSP BOARD SERVICING INFORMATION
98xx Audio/Logic Board Part Changes

98xx RF Board Part Change

DSP Board Parts List

Ref No. Description Part No.
ADDED PARTS

J 310 10-pin single in-line header 515-7100-010
J 311 10-pin single in-line header 515-7100-010

DELETED PARTS
Location

C 335 J302, pin 9 510-2625-479
R 354 U301D, pin 14 output jumper 569-0115-001
R 383 U303D, pin 14 output jumper 569-0115-001
U 102 U101, pin 32 (4K x 8 EEPROM) 544-5001-416

Ref No. Description Part No.
J201 20-pin connector, .82” pin male 515-7103-060

Ref No. Description Part No.
C 001 100 nF X7R ±10% 50V cer smd 510-3605-104
C 002 100 nF X7R ±10% 50V cer smd 510-3605-104
C 003 100 nF X7R ±10% 50V cer smd 510-3605-104
C 004 10 µF low ESR tantalum 510-2610-100
C 005 10 µF low ESR tantalum 510-2610-100
C 006 100 nF X7R ±10% 50V cer smd 510-3605-104
C 007 .001 µF NPO ±5% cer smd 510-3601-102
C 008 4.7 µF ±10% 50V tantalum 510-2622-479
C 009 390 pF ±5% NPO 50V cer smd 510-3601-391
C 010 390 pF ±5% NPO 50V cer smd 510-3601-391
C 011 4.7 µF ±10% 50V tantalum 510-2622-479
C 012 390 pF ±5% NPO 50V cer smd 510-3601-391
C 013 390 pF ±5% NPO 50V cer smd 510-3601-391
C 014 4.7 µF ±10% 50V tantalum 510-2622-479
C 015 100 nF X7R ±10% 50V cer smd 510-3605-104
C 016 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 017 10 µF low ESR tantalum 510-2610-100
C 018 10 µF low ESR tantalum 510-2610-100
C 019 100 nF X7R ±10% 50V cer smd 510-3605-104
C 020 100 nF X7R ±10% 50V cer smd 510-3605-104
C 021 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 022 100 nF X7R ±10% 50V cer smd 510-3605-104

C 023 100 nF X7R ±10% 50V cer smd 510-3605-104
C 024 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 025 100 nF X7R ±10% 50V cer smd 510-3605-104
C 026 100 nF X7R ±10% 50V cer smd 510-3605-104
C 027 100 µF 16V tantalum smd 510-2616-101
C 028 100 µF 16V tantalum smd 510-2616-101
C 029 100 µF 16V tantalum smd 510-2616-101
C 030 10 µF low ESR tantalum 510-2610-100
C 031 100 nF X7R ±10% 50V cer smd 510-3605-104
C 032 100 nF X7R ±10% 50V cer smd 510-3675-104
C 033 100 nF X7R ±10% 50V cer smd 510-3605-104
C 034 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 035 100 nF X7R ±10% 50V cer smd 510-3605-104
C 036 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 037 100 nF X7R ±10% 50V cer smd 510-3605-104
C 038 100 nF X7R ±10% 50V cer smd 510-3605-104
C 039 100 nF X7R ±10% 50V cer smd 510-3605-104
C 041 470 pF X7R ±10% 50V cer smd 510-3605-471
C 042 470 pF X7R ±10% 50V cer smd 510-3605-471
C 044 100 nF X7R ±10% 50V cer smd 510-3605-104
C 045 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 046 100 nF X7R ±10% 50V cer smd 510-3605-104
C 047 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 048 100 nF X7R ±10% 50V cer smd 510-3605-104
C 049 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 050 100 nF X7R ±10% 50V cer smd 510-3605-104
C 051 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 052 100 nF X7R ±10% 50V cer smd 510-3605-104
C 053 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 054 100 nF X7R ±10% 50V cer smd 510-3605-104
C 055 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 056 100 nF X7R ±10% 50V cer smd 510-3605-104
C 057 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 058 100 nF X7R ±10% 50V cer smd 510-3605-104
C 059 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 060 100 nF X7R ±10% 50V cer smd 510-3605-104
C 061 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 062 100 nF X7R ±10% 50V cer smd 510-3605-104
C 063 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 064 100 nF X7R ±10% 50V cer smd 510-3605-104
C 065 .001 µF NPO ±5% 50V cer smd 510-3601-102
C 066 100 nF X7R ±10% 50V cer smd 510-3605-104
C 067 .001 µF NPO ±5% 50V cer smd 510-3601-102

Ref No. Description Part No.
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DSP BOARD SERVICING INFORMATION

DSP BOARD PARTS LIST (CONT’D)
F 001 Fuse, 0.6A smd 534-5001-002

D 001 Dual switch-com cathode 523-1504-022

MP 182 Washer, insulated #6 fiber 596-4406-010
MP 185 0.197 swage mount 013-1188-053

PCB001 PC board, SN/SZ DSP (rev 7) 035-1825-180

PL 001 4-pin angle header, 1” center 515-9035-004
PL 002 10-pin single inline header 515-7100-010
PL 003 10-pin single inline header 515-7100-010

R 001 2.0k ohm ±5% 1/8W smd 569-0105-202
R 002 4.7k ohm ±5% 1/8W smd

(revised versions)
569-0105-472

0 ohm jumper
(unrevised versions)

569-0105-001

R 003 270k ohm ±5% 1/8W smd 569-0105-274
R 004 82k ohm ±5% cer smd 569-0105-823
R 005 160k ohm ±5% cer smd 569-0105-164
R 006 270k ohm ±5% 1/8W smd 569-0105-274
R 007 0.5 ohm ±5% 1W smd 569-0175-05A
R 008 6.8k ohm ±5% 1/8W smd 569-0105-682
R 009 15k ohm ±5% 1/8W smd 569-0105-153
R 010 18k ohm ±5% 1/8W smd 569-0105-183
R 011 1.8k ohm ±5% 1/8W smd 569-0105-182
R 012 15k ohm ±5% 1/8W smd 569-0105-153
R 013 30k ohm ±5% 1/8W smd 569-0105-303
R 014 30k ohm ±5% 1/8W smd 569-0105-303
R 015 10k ohm ±5% 1/8W smd 569-0105-103
R 016 30k ohm ±5% 1/8W smd 569-0105-303
R 017 30k ohm ±5% 1/8W smd 569-0105-303
R 018 18k ohm ±5% 1/8W smd 569-0105-183
R 019 2.0k ohm ±5% 1/8W smd 569-0105-202
R 020 10k ohm ±5% 1/8W smd 569-0105-103
R 021 10k ohm ±5% 1/8W smd 569-0105-103

Ref No. Description Part No.
R 022 10k ohm ±5% 1/8W smd 569-0105-103
R 023 10k ohm ±5% 1/8W smd 569-0105-103
R 024 10k ohm ±5% 1/8W smd 569-0105-103
R 025 10k ohm ±5% 1/8W smd 569-0105-103
R 026 2.0k ohm ±5% 1/8W smd 569-0105-202
R 028 2.0k ohm ±5% 1/8W smd 569-0105-202
R 029 100 ohm ±5% 1/8W smd 569-0105-101
R 030 270k ohm ±5% 1/8W smd 569-0105-274
R 031 10k ohm ±5% 1/8W smd 569-0105-103
R 032 10k ohm ±5% 1/8W smd 569-0105-103
R 033 10k ohm ±5% 1/8W smd 569-0105-103
R 034 10k ohm ±5% 1/8W smd 569-0105-103
R 035 10k ohm ±5% 1/8W smd 569-0105-103

SK 002 Crystal socket 515-5006-018
SK 003 Crystal socket 515-5006-018
SK 004 Crystal socket 515-5006-018
SK 005 Crystal socket 515-5006-018

U 001 Fixed point DSP TMS320VC5402 544-5003-121
U 002 Audio CODEC PCM3002 544-3016-055
U 003 64K x 163V SRAM MCM6323A 544-5001-130
U 004 256K x 16 FLASH AM29LV800 544-9050-020
U 005 Voltage regulator TPS7201QD 544-2003-153
U 006 Voltage reg 3.3V TPS7333QD 544-1020-009
U 007 32K x 8 EEPROM AT24C256W 544-1020-256
U 008 Op amp, quad MC3303 544-2020-008
U 009 Hex inverter SN74LVC04A 544-3774-020
U 010 Hex inverter SN74LVC04A 544-3774-020
U 011 Voltage reg 3.3V TPS7333QD 544-1020-009
U 012 Bus xcvr, octal SN74LVCC3245 544-1010-248
U 013 Bus xcvr, octal SN74LVCC3245 544-1010-248
U 015 Voltage regulator, 5V TL750M 544-1020-750
U 016 2 input OR quad 74HC32 544-3766-032

Y 001 Crystal, 4.096 MHz smd 521-3060-061

Ref No. Description Part No.
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DSP BOARD SERVICING INFORMATION
DSP BOARD CONNECTIONS TO AUDIO/LOGIC BOARD

PL1
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4
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PL2 PL3

SK4 SK5

SK3
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DSP Board

Audio/Logic
Board
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DSP BOARD SERVICING INFORMATION
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